
The New command (Database menu)
Use this command to create a new database.
The Create New Database wizard appears.

Note: This function is not available in all versions of DesignPro.



The Create New Database wizard
Use this wizard to create a new database. The database is saved in dBase III format (*.dbf). Follow the instructions in
sequence.
First select the button under 1. Set File Name. The Save dBase Database As dialog box appears.
The button under 2. Create Fields opens the Create Database Fields dialog box. At least one field must be created 
so that the database can be generated.
Generate the database file under 3. Create Database. The database is linked with the document and can be edited.

Note: This function is not available in all versions of DesignPro.



The Save dBase Database As dialog box
Select the computer on which the new database is to be stored and enter a file name.
The database is saved in dBase III format (*.dbf).



The Field Parameters dialog box
In the Field Parameters dialog box you can define the properties of a new database field or change the properties of 
an existing database field.
To create a new field:

Field Name Enter the name of the field that you want to add. Once a name is entered, Insert is activated. 
The field name can be a maximum of 10 characters in length.

Field Length Enter the length of the field here. The maximum field length is 255 characters. If you insert a 
date field, the field length is automatically set to 8.

Field Data Type Select the field data type you want. You can insert text fields, integer fields, floating point 
number fields and date fields.

Decimal Places When you are inserting a floating point number field, you can set the number of decimal 
places here. The number of decimal places must be less than the field length.

Select OK to insert the specified parameters into the field list.

To modify an existing field change the Field Name, Field Data Type, Field Length or Decimal Places and select 
OK.
The following field data types modifications are possible for dBase databases:

· Text to integer
· Text to floating point number
· Text to date
· Integer to text
· Integer to floating point number
· Floating point number to text
· Floating point number to integer
· Date to text

Note: When converting from type date to type text, the new text field must be at least 10 characters long.
If an error occurs during the modification a notification appears and the modification as a whole won’t be applied. The
original database is restored instead, if possible.
If the Field Length or the amount of Decimal Places are being reduced a loss of data might be possible.

Note: This function is not available in all versions of DesignPro.



The Open and Restore Connection commands (Database menu)
Use the Open command or the  icon to open an existing database.
The Open Database dialog box is displayed.
If you have already closed the connection to an open database with the Close command, the Restore Connection 
command appears in the Database menu instead of the Open command. Use this command or the  icon to 
restore the connection with the open database.
You can create a new database in the Database menu with the New command.

Note: This function is not available in all versions of DesignPro.



The Open Database dialog box
In the Open Database dialog box you can open either an ODBC or a dBase database.
You can open an existing dBase III file directly with the dBase III button. The Open dBase Database dialog box is 
displayed.
You can open an existing, external database via the ODBC database interface with the ODBC button.
The Select Data Source dialog box (or the Datenquelle auswählen dialog box) appears. The dialog boxes for 
database set-up can be displayed in German or in English, depending on the Microsoft ODBC driver.
DesignPro supports current database systems with the ODBC standard. To import various database formats, the 
ODBC drivers must be installed.

Note: This function is not available in all versions of DesignPro.



The Open dBase Database dialog box
DesignPro supports database files in dBase III format. These can be opened without additional drivers.
DesignPro supports the current dBase data types. DesignPro does not support indexes. The database can contain a 
maximum of 1000 records.
Select a dBase III file and click OK to open it.

Note: This function is not available in all versions of DesignPro.



Importing data from an external database
1. Select a label template in the File menu with the New command.

2. To establish the connection to an external database, open the Open Database dialog box using the Open 
command in the Database menu.

3. Use the ODBC button to open the Select Data Source dialog box.

4. Select the Machine Data Source tab in the Select Data Source dialog box. A list with the data source names 
(DSN) appears depending on the ODBC drivers installed.

5. Select the data source you want and confirm with OK.
A request to log on may appear at this point. If so, enter your name and password in the dialog box.
If the database file contains several tables, you will be asked to select the table you require. The connection 
with the database is now set up.

6. Insert database fields in the master label with the Insert Field command.

7. To create a new data source, click on the New button.

Note: This function is not available in all versions of DesignPro.



Select Table/File and Tables - Options
Select the table or file you want to open from the list.
Use the Options button to open the Tables - Options dialog box. You can define here which elements (tables, views,
system tables, synonyms) to display in the list.



Creating a new data source
…is explained here using the example of an Access file.

1. Select a label template in the File menu with the New command.

2. Establish a connection to an external database with the Open command in the Database menu.

3. Use the ODBC button to open the Select Data Source dialog box.

4. Select the Machine Data Source tab in the Select Data Source dialog box. A list with the data source names 
(DSN) appears depending on the ODBC drivers installed.

5. To create a new data source, click on the New button.

6. Select System Data Source and confirm with Next.

7. Select the ODBC driver for your data source from the list, e.g. a Microsoft Access driver (*.mdb) and click on 
Next. The following drivers are available with a fully installed Microsoft ODBC kit: Access, dBase, Excel, FoxPro
and Text. Other ODBC drivers can also be installed.

8. A summary of the settings appears, which you confirm with Finish.

9. The dialog box then displayed depends on the ODBC driver selected. For an Access database the ODBC 
Microsoft Access 97 Set-up dialog box appears. Under Data Source Name enter the name of the data 
source, for example, "Customer Address". You can decide whether to specify an additional description in the 
Description field. Note that some keywords are not permitted in database and table names (e.g. "database", 
"integer").

10. Click Select and select the database file (e.g. Customer.mdb). Click OK.

11. Clicking OK returns you to the list of data source names. The new data source, e.g. "Customer Address", 
appears in the list of data source names.

12. Select the data source you want and confirm with OK. If the database file contains several tables, you will be 
asked to select the table you require. The connection with the database is now set up.

Since the functionality and look-and-feel of the database functions depend on the installed ODBC components, the 
details of the procedure may differ.    For further information on ODBC and database applications, please refer to the 
corresponding documentation and online Help.

Note: This function is not available in all versions of DesignPro.



The Select Data Source dialog box
If you have selected the ODBC button in the Open Database dialog box, you can open databases via the ODBC 
database interface in the Select Data Source dialog box. You have the option of choosing between file data sources 
and machine data sources.
DesignPro supports the current ODBC data types.
You can get Help on the individual elements of this dialog box by using the F1 key or the right mouse button.
Note that some keywords are not permitted in database and table names (e.g. "database", "integer").



Supported ODBC data types
DesignPro supports the following ODBC data types.

Text ODBC data type String for sequences with fixed or variable lengths.

Number ODBC data type Integer contains integers (-32 768 to 32 768)
ODBC data type Single contains floating point numbers accurate to one place
ODBC data type Double contains floating point numbers accurate to two places.
ODBC data type Long Integer contains large whole numbers (-2 147 483 648 to 2 147 483 648).

Date/Time ODBC data type Date is used for date and time information. Date and Time are entered in accordance 
with the abbreviated format set in the system settings.
Years entered as two digits are treated as full years. Years written as two digits from 30 upwards 
(inclusive) are prefixed with 19 (1930 – 1999); Values up to and including 29 are prefixed with 20 (2000 
– 2029). An error message appears if an incorrect date or time is entered (for example, if the date does
not exist).

Yes/No ODBC data type Boolean

Databases that contain other data types (e.g. graphics, OLE objects, currency) can be used in DesignPro. However, 
only fields of the data types listed above can be inserted. If a data type is not supported, the field is not displayed in 
the Edit Database dialog box (Database menu, Edit command).

Note: This function is not available in all versions of DesignPro.



Supported dBase data types
DesignPro supports the following dBase data types.

Text dBase data type Character for sequences of fixed length (ASCII characters). The 
maximum field length is 255 characters.

Integer dBase data type Numeric contains integers with the characters 0 to 9 and algebraic signs.

Floating Point Number dBase data type Numeric contains floating point numbers (e.g. 42.12345). Permitted 
characters are algebraic signs, decimal delimiters and the characters 0 to 9. The 
maximum field length is 255 characters. Up to 15 decimal places including decimal 
delimiters can be processed. The decimal delimiter must be entered in accordance with 
the system settings.

Date dBase data type Date. The date is entered in accordance with the abbreviated format set 
in the system settings. Years entered as two digits are treated as full years. Years written 
as two digits from 30 upwards (inclusive) are prefixed with 19 (1930 – 1999); Values up to 
and including 29 are prefixed with 20 (2000 – 2029). An error message appears if an 
incorrect date is entered (for example, if the date does not exist).

Databases that contain other field types can be used in DesignPro. However, only fields of the data types listed 
above can be inserted. If a data type is not supported, the field is not displayed in the Edit Database dialog box 
(Database menu, Edit command).

Note: This function is not available in all versions of DesignPro.



Fields in Access and Excel files with the Currency data type are an exception. The Currency data type can be 
imported from Access and Excel files.



The File Data Source tab
In the Look in list field select the directory with the DSNs (Data Source Names). The following directory is specified 
by default here.
Programs\Common Files\ODBC\Data Sources or 
Program Files\Common Files\ODBC\Data Sources.
The file DSNs contained in the current directory are displayed in a list. Select the required file DSN by clicking it with 
the mouse. The file name appears in the DSN Name field. You can set up the connection to the database by clicking 
on the desired file DSN.
If you want to insert an new file DSN, select the New button.



Create New Data Source
With the Create New Data Source wizard, you can insert a new file data source and set up the connection to this 
data source.
Select the driver with which you want to configure the data source. The Name, Version, Company, File and Date of 
the each driver are displayed in the list box.    When you click on Next, you must enter the name of the path and the 
name under which you want to store the file data source, or select the directory with Browse. In the Save As dialog 
box, you must enter a new file DSN for the connection with the database file in the File Name field.
Click Next to check the details for the data source you are creating and then select Finish. The new file data source 
is then added in the directory under the specified file DSN.

Note: This function is not available in all versions of DesignPro.



The Machine Data Source tab
Machine data sources are linked to a computer. There is a difference between user data sources and system data 
sources.
User data sources are linked to a user of a computer. System data sources can be used by all users of a computer or
by a system-wide service.
Select the appropriate data source from the list box. The Type of the data source and a Description are displayed in 
the list box beside the Data Source Name. Click OK to open the machine data source.
If you want to insert a new machine data source, select the New button.



Create New Machine Data Source
With the Create New Data Source wizard, you can insert a new machine data source and set up the connection to 
this data source.
Define the data source type. There is a difference between user and system data sources.
A User Data Source is linked to the computer and only visible to the current user.
A System Data Source is also linked to the computer but can be accessed by several users.
Select the driver with which you want to configure the data source. The Name, Version, Company, File and Date of 
the current driver are displayed in the list box.    When you click on Next, you must enter the name and the path under
which you want to store the file data source, or select the directory with Browse. In the Save As dialog box, you must
enter a new file DSN for the connection with the database file in the File Name field.
Click Next to check the details for the data source you are creating and then select Finish. The new machine data 
source is then added in the directory under the specified file DSN.

Note: This function is not available in all versions of DesignPro.



The Create Database Fields / Modify Database dialog box
Select Insert new … to insert a new field and set its parameters in the Field Parameters dialog box.
Select a field in the Fields list and press Edit… to change the field parameters in the Field Parameters dialog box. 
Select a field in the Fields list and use the 'up' and 'down' arrows to move the field up or down one position in the 
field list. The buttons are only enabled when the Fields list contains at least two fields with one field selected.
Select a field it in the Fields list and choose Delete to delete the field. Use Delete All to delete all fields.
Note: Deleting a field in an existing dBase database (Modify database) also deletes any data contained in this field.

Check the Tag Field checkbox to add a tag field to your dBase database. This field can be used as another filter 
condition.

Note: This function is not available in all versions of DesignPro.



The Close command (Database menu)
Use this command to close the connection with the database currently opened.
The Restore Connection command appears in the Database menu instead of the Open command.
To permanently close the connection with a database, use the Deactivate command.

Note: This function is not available in all versions of DesignPro.



The Edit command (Database menu)
Use this command or the  icon to edit and browse the records in a database.
The Edit Database dialog box is displayed.

Note: This function is not available in all versions of DesignPro.



The Search Database dialog box
You can search the records by search terms in the Search Database dialog box.

Search Enter the term you want to find here.

In Field From the list, select the field in which you want to search for the term. You can also enter the 
field name manually.

First Record Click this button to start the search. The record found is displayed in the Edit Database dialog
box.
If no record is found, a message is displayed.

Next Record Select this button to display the next record that contains the search term.

Close Ends the search and closes the dialog box.

Note: This function is not available in all versions of DesignPro.



The Edit Database dialog box
The records of the database currently opened are displayed in the Edit Database dialog box. You can edit records 
and insert or delete records using the relevant buttons. 
The format of the entered data depends on the field data type. The format for the output of data in the document 
depends on the specifications in the General tab (Options command, Tools menu).
The entered or modified data is automatically saved each time you toggle between the records. These changes 
cannot be undone.

OK Click OK to close the dialog box and to accept the changes.

New Record Inserts a new record. The fields of the inserted record are empty.

Delete Deletes the current record.

Restore You can cancel the changes to a record with this button.

Search You can search the records by search terms in the Search Database dialog box.

Further controls which are only available for dBase databases:

Duplicate Inserts a copy of the current record at the end of the database.

Tag Mark this checkbox to tag the current record.

Tag All Tags all current records.

Untag All Untags all current records.

You can toggle between the records with the  button.

The Record Number shows the number of the current record and the total amount of records in the dBase database.
Note: This function is not available in all versions of DesignPro.



The Sort command (Database menu)
Use this command or the  icon to sort the records in a database.
You can set the sort key in the Sort Records dialog box.
The last sort key used is saved for use again later.

Note: This function is not available in all versions of DesignPro.



The Sort Records dialog box
You can sort the records by field in the Sort Records dialog box.

Sort Keys From the list of field names, select the field by which the contents of which the records are to be 
sorted. You can sort in ascending or descending order. Ascending sort order is activated by 
default. You can set up to three sort keys.

OK Click OK to close the dialog box and to begin sorting.

Cancel Use Cancel to close the dialog box without sorting.

Delete All Click this button to delete the settings of all the sort keys.

Sorting remains active until you deactivate it or until the document is closed. Sorting can also be used for printouts. 
When toggling between records, the records are displayed in the specified sort order.
The sort key is saved for use again later.

Note: This function is not available in all versions of DesignPro.



The Filter command (Database menu)
Use this command or the  icon when searching for a group of records that fulfil specific criteria.
You can specify the criteria for the query in the Filter Records dialog box. The filter criteria are stored so that the 
query can be repeated later.
If you are looking only for a record that contains a specific value, a search with the Edit command is probably more 
efficient.

Note: This function is not available in all versions of DesignPro.



The Filter Records dialog box
You can specify the criteria for querying a database in the Filter Records dialog box. DesignPro supports the setting 
of multiple filters.
Filter conditions remain active until you deactivate them or until the document is closed. Filters can also be used for 
printouts. When toggling between records, only records that match the filter criteria appear.
The filter criteria are stored so that the query can be repeated later.

Field Select from the list the field for which you would like to define selection criteria.

Compare Select from the list the way in which you want to perform the compare.

Compare With Enter here the criterion or the value with which the field content is to compared.
You can use wildcards here if the field contains data of the data type Text. This option does not 
exist for comparisons with other data types. The wildcards are different for ODBC and dBase 
databases but correspond to the usual characters in each case.
For ODBC databases, the underscore "_" wildcard is used for exactly one character. The percent 
sign, "%", is a wildcard for any number of characters.
For dBase databases, the question mark, "?",    is a wildcard for just one character. The asterisk, 
"*", is a wildcard for any number of characters.

And/Or Select And or Or to link the criteria between different fields.

Only Tagged Records All records which match the filter conditions AND are tagged (available only for dBase 
databases containing a tag field).

OK Click OK to close the dialog box and to start the query.

Cancel Use Cancel to close the dialog box without filtering.

Delete All Click this button to delete all filter settings.

If no record fulfils the filter criteria, no record is displayed in the Edit dialog box and the fields of the record mask 
remain empty.

Note: This function is not available in all versions of DesignPro.



The contents of this field are compared in all records with the information you entered under Compare With:.
To find all records that have the word "Mrs." in the address field, for example, select the Address field name in the 
Field field, then click on Equal in the Compare field and enter "Mrs." in the Compare With field.



Use the operator that you have selected from the list to define which information is to be filtered and which is to be 
omitted. The operators can apply to numbers, letters and words.
For example, with the Equals operator, all records that correspond to the information in the Compare With field are 
selected. In contrast, the Not Equal operator selects all records that do not contain this information. The Greater 
Than/Less Than operators, as well as Less Than Or Equal/Greater Than Or Equal work in the same way.
Exceptions are the Empty/Not Empty operators. These operators can be used to select records without or with 
content. The Compare With field is deactivated since no compare criteria are required.



The value you enter in the Compare With field is compared with the information in the selected record.
To find all records that have the word "Mr." in the address field, for example, select the Address field name in the 
Field field, then click on Equal in the Compare field and enter "Mr." in the Compare With field.



Linking several filter criteria
You can set up to six filter criteria by linking them with And or Or.
Use And to select records that fulfil all filter criteria. The operator

And
Name Equal Smith
Location Equal Smithsville

returns all records containing "Smith" in the Name field and "Smithsville" in the Location field.
The Or operator selects all records that fulfil at least one criterion. The operator

Or
Name Equal Mayer
Name Equal Miller

returns all records that contain "Mayer" or "Miller" in the Name field.
By combining And and Or, complex queries can be performed. For example, the operator

And
Or
And

Location Equal Smithsville
Name Equal Mayer
Location Equal Smithsville
Name Equal Miller

returns all records that contain "Mayer" or "Miller" in the Name field and "Smithsville" in the Location field.
Combining the criteria with And gives a closer association than combining with Or. This means that the And operator
is executed first.



The Insert Field command (Database menu)
Use this command or the  icon to insert a field of a record in a text object or a round text object.
The Insert Field dialog box is displayed.
Record fields can only be inserted in text objects that are on the master label. This command is deactivated for other 
labels.

Note: This function is not available in all versions of DesignPro.



The Insert Field dialog box
A list of the field names of a record of the currently open database is displayed in the Insert Field dialog box.
Select the field you want and click OK.
The field is inserted in the text object at the cursor position. If no text object is selected, the field is inserted in the 
upper left corner of the label.
Use the buttons Space, Tabulator and New Line to insert the corresponding white spaces at the current position of 
the cursor.
The content of a field can be displayed with the Display Field Contents command.
DesignPro supports the current ODBC data types and dBase data types.

Note: This function is not available in all versions of DesignPro.



The Euro Conversion dialog box
In the Euro Conversion dialog box you can choose the currency and the direction of the conversion.

Note: This function is not available in all versions of DesignPro.



The Insert Picture command (Database menu)
Use this command to insert a picture in a label from a database field. The name of the graphics file and, if necessary, 
its path are transferred from the selected field of the open database.
Since every record can contain a different graphics file, you can create similarly formatted labels with different 
graphics.
The Insert Picture from Database dialog box is displayed.

Note: This function is not available in all versions of DesignPro.



The Insert Picture from Database dialog box
A list of the field names of a record of the currently open database is displayed in the Insert Picture from Database 
dialog box.
Under Field Name select the field which contains the graphics specifications. The name of the graphics file complete 
with its file extension must be in the appropriate field of the record. The details of the path can either be in the record 
(useful, if pictures are located in different directories), or the path must be set in the Text/Picture tab under 
Properties, in the Format menu.
If the path is not in the record, you can add the path by activating Specify Directory Name. You can search for the 
corresponding directory which contains the pictures using the Browse function.
Click OK to insert the field.
The picture is inserted in the upper left corner of the label. The size of the inserted picture can be modified like a 
normal picture. Since the field with the picture is inserted on the master label, the size of the field remains the same, 
irrespective of the size of the picture inserted from the database. This means there can be distortions if pictures of 
different sizes are inserted. 
If a picture cannot be inserted from a database, for example, if the path or file cannot be found, a blue, diagonal cross
appears.
When inserting metafiles (*.wmf) from a database, please note that metafiles cannot be displayed rotated. If, for 
example, both bitmaps and metafiles are inserted from one database, and they are to be rotated, only the bitmaps 
are displayed rotated.



The Deactivate command (Database menu)
Use this command to cancel the connection with a database. To restore the connection, you must open the database 
again using the Open command (Database menu).
If all you want is to close a connection, select the Close command.

Note: This function is not available in all versions of DesignPro.



The Go To command (Database menu)
Use this command or the  icon to toggle between records within a database.

First Record Displays the first record.

Next Record Displays the next record.

Previous Record Displays the previous record.

Last Record Displays the last record.

If a filter is activated, only the records of the database that correspond to the filter are displayed.
For an activated Sort, the records are displayed in the specified sort order.



The Display Field Contents command (Database menu)
Use this command to display on the screen the content of a field that has been inserted in a text object with the Insert
Field command. You can use the Go To command to toggle between records and display the field content of different 
records.
If this option is deactivated, only the field name appears on the screen.
The field contents of the active record are always displayed in the Print Preview.



The Database Info command (Database menu)
Use this command to obtain information on the current database. The Database Info dialog box is displayed.



The Database Information dialog box
The Database Information dialog box shows the following information:

File Path of the currently opened database file.
Status Database is connected or disconnected.
Total Number of Records Total amount of records in the dBase database including all deleted records.
Number of Active Records Amount of available records (matching the filter conditions).

Use the button Compress Database to remove deleted records from the dBase database.



The Select command (Drawing menu)
Use this command to activate selection mode. 
Move the mouse pointer to the position where you wish to edit. You can select a single object or multiple objects.



The mouse pointer
The mouse pointer changes in appearance according to its position or function:

Normal selection  or custom setting (Windows Control Panel – Mouse Properties): Mouse pointer over an 
empty workspace or within an unfilled object.

Move  or custom setting: Mouse pointer within a filled, closed object. (No fill colour: Normal selection icon).

Resizing: Vertical , Horizontal 

, Diagonal 

 

 or custom setting: Mouse pointer with resizing handles for enlarging or reducing.

Text selection  or custom setting: Text input.
In a text object without a fill colour, the text selection icon only appears in the described text object; in 
a text object with a fill colour it appears in the entire text object.

Anchor , no custom setting possible: Object is anchored (Edit menu, Anchor command).

Lock content , no custom setting possible: The contents of the text object are locked (Edit menu, Lock Content 
command)

Help selection  or custom setting: Help for the individual screen elements with the What’s This? function.

Precision selection  or custom setting: Mouse pointer when an object is being created (e.g. rectangle, text 
object, bar code or line).



Selecting an object
1. Move the mouse pointer over the object and click the left mouse button.

2. Eight handles are displayed on the selected object. If the handles are white, you can enlarge/reduce the object in 
size. If they are black, the object cannot be resized.

Master label objects can only be edited/selected in the master label, even though they are visible on the other labels. 
The background design of labels cannot be selected.



Selecting multiple objects
1. Using the mouse, drag a rectangle around all the objects you wish to select. Start in a blank area of the label 

(normal mouse pointer), click the left mouse button and keep it pressed while you draw the rectangle. Make sure 
that each object is drawn completely.
With text objects, the text displayed is sometimes smaller than the actual text object. However, the text object 
must still be drawn completely.

2. You also have the option of selecting several objects by selecting each object individually. Keep the SHIFT key 
pressed while you select the other objects with the mouse pointer. When you have selected all of the objects, 
release the SHIFT key.

3. If you want to select all of the objects on a label, choose the Select All command in the Edit menu.

4. Eight handles are displayed around the area containing the selected objects. If these handles are white, you can 
enlarge or reduce the objects in size. If the handles are black, the objects cannot be resized. The objects can only
be moved.

With a multiple selection, you can also edit the object properties.



Features of multiple selection
1. Object properties (e.g. size, colour, line thickness, rotation, etc.) that you can change for a multiple selection are 

valid for all objects in the multiple selection. If a multiple selection contains objects which have different properties 
(e.g. different fill colours), the relevant fields remain blank. If you then enter a fill colour, for example, all objects in 
the multiple selection are displayed with this fill colour.

2. If you rotate a multiple selection (Format menu, Rotate command), each object is rotated on its own axis. If you 
wish to rotate objects on a common, central axis, group the objects using the Group command in the Drawing 
menu. 

Not all functions are available in the multiple selection.

1. For example, if the multiple selection contains a rotated object, it is not possible to enlarge/reduce the size of the 
entire selection. If you wish to change the size of the selection, you must group it first. 

2. For example, if the multiple selection contains one or more anchored objects, it is not possible to move or 
enlarge/reduce them.



The Text command (Drawing menu)
Use this command or the  icon to insert a text object in the drawing.

1. Click the Text icon with the left mouse button or select the command from the Drawing menu. 

2. Move the mouse pointer to the position where you wish to insert a text object. 

3. If you wish to define the size of the text object yourself, select the starting point for the text object with the first 
click of the left mouse button, hold the button down and then drag the text object to the required size. The position
where you release the mouse button is the end point of the text object.
When you click the left mouse button you open a text object with an automatically defined size which you can later
change.
If you hold down the SHIFT key when inserting a text object, a square text object is inserted.

4. The dimensions of the text object are displayed in grey in the ruler. If you wish to precisely define the size and 
position, select the Properties command in the Format menu. Here you can define the size, position, lines and 
colours, rotation and text margin more precisely with the help of the tabs. 

5. If you wish to position the text object more precisely, it is recommended that you use the Grid or Guides.

The current settings for the font, line and colour properties are used for the text object. You can edit these properties 
at a later stage.



Drawing circles and squares
To draw squares or circles, hold down the SHIFT key when you are inserting rectangles or ellipses. Square or circular
text objects are generated in the same way.

1. Select the required command (e.g. Rectangle or Text) from the Drawing menu or click the relevant icon.

2. Move the mouse pointer to the position where you wish to insert the object.

3. Hold down the SHIFT key while you select the starting point of the object with the mouse pointer and drag the 
object to the required size. The position where you release the mouse button is the end point of the object.



Editing a text object
To select a text object, you must click on the border of the text object using the mouse. The mouse pointer appears 
as the Move icon.
You can change the size of the text object by dragging the handles on its border. The text formatting is adjusted 
automatically.



The Round Text command (Drawing menu)
Use this command or the  icon to insert a round text object in the drawing. Round text can be displayed in a circle 
or an ellipse.

1. Click the Round Text icon with the left mouse button or select the command from the Drawing menu. 

2. Move the mouse pointer to the position where you wish to insert the round text. 

3. If you wish to define the size of the round text object yourself, select the starting point for the text object with the 
first click of the left mouse button, hold the button down and then drag the text object to the required size. The 
position where you release the mouse button is the end point of the text object.
When you click the left mouse button you open a text object with an automatically defined size which you can later
change.
If you hold down the SHIFT key when inserting a round text object, a circular text object is inserted.

4. The dimensions of the text object are displayed in grey in the ruler. If you wish to precisely define the size and 
position, select the Properties command in the Format menu. Here you can define the size, position, lines and 
colours, rotation and text margin more precisely with the help of the tabs. 

5. If you wish to position the text object more precisely, it is recommended that you use the Grid or Guides.

6. When you select the Snap Text to Ellipse command in the Format menu you can specify how the text is to be 
aligned with the ellipse.

The current settings for the font, line and colour properties are used for the text object. You can edit these properties 
at a later stage.

To select a text object, you must click on the border of the text object using the mouse. The mouse pointer appears 
as the Move icon.

Enter the text. The current settings for the font, line and colour properties are applied to the text object. 
To display the text as round text, click outside the text object with the mouse. The text is aligned with the ellipse.



Editing a round text object

1. To select a text object, you must click on the border of the text object using the mouse. The mouse pointer 
appears as the Move icon.

2. You can change the size of the text object by dragging the handles on its border. The text formatting is adjusted 
automatically.

You can change the position and display of the round text by selecting the Snap Text To Ellipse command in the 
Format menu.



The Bar Code command (Drawing menu)
Use this command or the  icon to insert a bar code. 

1. Click the Bar Code icon with the left mouse button or select the command from the Drawing menu. 

2. Move the mouse pointer to the position where you wish to insert a bar code. 

3. If you wish to define the size of the bar code field yourself, select the starting point for the field with the first click of
the left mouse button, hold the button down and then drag the text field to the required size. The position where 
you release the mouse button is the end point of the bar code field.
When you click the left mouse button you open a bar code field with an automatically defined size which you can 
later change.

4. The dimensions of the bar code field are displayed in grey in the ruler. If you wish to precisely define the size and 
position, select the Properties command in the Format menu. Here you can define the size, position, lines, 
colours and rotation more precisely with the help of the tabs. For example, if you do not wish the background of 
the bar code to be transparent, disable None in the Lines and Colours tab and select the required background 
colour (fill colour) from the list.
You can change the default settings for bar code fields in the Colours/Lines/Pictures tab under the Options 
command in the Tools menu.

5. If you wish to position the bar code field more precisely, it is recommended that you use the Grid or Guides.

6. Enter the plaintext in the input field. You also have the option of aligning the plaintext in the bar code field by 
selecting the Alignment command from the Format menu. Formatting cannot be applied to the text within a bar 
code. When you click outside the bar code field with the mouse, the bar code is displayed with the relevant bar 
code parameters.

Note: This function is not available in all versions of DesignPro.

If you can’t create the bar code…



The plaintext is the character string that is encoded in the bar code.



If the bar code cannot be created after entering the plaintext, it is possible that you entered a character string that is 
not supported by the selected bar code type.
Possible sources of errors are characters that are not supported (e.g. letters or symbols) or a number of characters 
that is not compatible with the bar code type.
Information on the character set and format can be found in the list of bar code types.
Note: Creating bar code objects is not possible in all versions of DesignPro.



Editing a bar code 
You can change the size of a bar code object by dragging the handles on its border.
To define the bar code type and set the bar code parameters, select the Bar Code Parameters command in the 
Format menu.

Note: This function is not available in all versions of DesignPro.



The Line command (Drawing menu)
Use this command or the  icon to toggle to line drawing mode. In line drawing mode you can draw a basic line in 
the current line colour and line thickness. You can change the default settings for line colour and line thickness in the 
Colours/Lines/Pictures tab under the Options command in the Tools menu.

1. Click on the starting point with the mouse and hold down the left mouse button while you drag the line to the end 
point. If you hold down the SHIFT key when creating a line, horizontal or vertical lines are drawn depending on 
which way you move the mouse.

2. When you release the mouse button both points are joined together and selection mode is activated automatically.

You can use the Polygon command to draw a line consisting of multiple segments (polyline/polygon) or a freehand 
line.



The Rectangle command (Drawing menu)
Use this command or the  icon to toggle to rectangle drawing mode. In rectangle drawing mode you can draw 
rectangles with the current properties for fill colour, fill pattern, line thickness and line colour using the mouse. You 
can change the default settings for fill colour, fill pattern, line colour and line thickness in the Colours/Lines/Pictures 
tab under the Options command in the Tools menu.

1. Click on the starting point with the mouse and hold down the left mouse button while you drag the rectangle to the
required size. If you hold down the SHIFT key when inserting a rectangle, a square is inserted.

2. When you release the mouse button selection mode is activated automatically.

You can change the position and size at a later stage.



Drawing a rectangle

1. Use the Rectangle command in the Drawing menu or click on the  icon in the Drawing toolbar.

2. Click the left mouse button at the position where the rectangle is to be inserted and move the mouse while holding
down the mouse button. The rectangle is stretched from the anchor point to the mouse position. The rectangle is 
enlarged or reduced in size, depending on which way you move the mouse. When you click the left mouse button 
you open a rectangle with an automatically defined size.

3. When the rectangle has reached the required size, release the mouse button. The rectangle is positioned in the 
drawing area.

4. To edit the rectangle, you can click on the handles and move them as required.

5. If you wish to draw a square, hold down the SHIFT key while you are drawing the rectangle.

6. The dimensions of the rectangle are displayed in grey in the ruler. If you wish to precisely define the size and 
position, select the Properties command in the Format menu. Here you can define the size, position, lines and 
colours, rotation and text margin more precisely with the help of the tabs. 

7. If you wish to position the rectangle more precisely, it is recommended that you use the Grid or Guides.



The Polygon command (Drawing menu)
Use this command or the  icon to toggle to polygon drawing mode.
In polygon drawing mode you can draw polygons with the current properties for fill colour, fill pattern, line thickness 
and line colour using the mouse. You can change the default settings for fill colour, fill pattern, line colour and line 
thickness in the Colours/Lines/Pictures tab under the Options command in the Tools menu.

To display the polygon as a filled area, it must have a colour or fill pattern. You can define this property in the Format 
menu with the Fill Colour and/or Fill Pattern commands.
You can also draw polylines and freehand lines in polygon drawing mode. You must activate None for the fill colour 
and No Fill Pattern for the fill pattern. Otherwise the line is closed automatically and filled with the defined colour.

1. With the first click of the mouse you define the starting point, with each subsequent mouse click you define 
another point of the polygon or line. 

2. If you hold down the left mouse button you can draw a freehand line. 

3. Double-click to exit polygon drawing mode. 

4. When creating a filled polygon, the line is closed automatically between the starting point and the end point.



The Ellipse command (Drawing menu)
Use this command or the  icon to toggle to ellipse drawing mode. In ellipse drawing mode you can draw ellipses 
with the current properties for fill colour, fill pattern, line thickness and line colour using the mouse. You can change 
the default settings for fill colour, fill pattern, line colour and line thickness in the Colours/Lines/Pictures tab under the 
Options command in the Tools menu.

1. Click on the starting point with the mouse and hold down the left mouse button while you drag the ellipse to the 
required size. If you hold down the SHIFT key when inserting the ellipse, a circle is inserted.

2. When you release the mouse button selection mode is activated automatically.

You can change the position and size at a later stage.



Drawing an ellipse

1. Use the Ellipse command in the Drawing menu or click on the  icon in the Drawing toolbar.

2. Click the left mouse button at the position where the ellipse is to be inserted and move the mouse while holding 
down the mouse button. The ellipse is stretched from the anchor point to the mouse position. The ellipse is 
enlarged or reduced in size, depending on which way you move the mouse. When you click the left mouse button 
you open an ellipse with an automatically defined size.

3. When the ellipse has reached the required size, release the mouse button. The ellipse is positioned in the drawing
area.

4. To edit the ellipse, you can click on the handles and move them as required.

5. If you wish to draw a circle, hold down the SHIFT key while you are drawing the ellipse.

6. The dimensions of the ellipse are displayed in grey in the ruler. If you wish to precisely define the size and 
position, select the Properties command in the Format menu. Here you can define the size, position, lines and 
colours, rotation and text margin more precisely with the help of the tabs. 

7. If you wish to position the ellipse more precisely, it is recommended that you use the Grid or Guides.



The Order command (Drawing menu)
Use these commands or icons to define the order in which the objects are to be drawn.

 Bring To Front The selected object is displayed in front of all objects within the label.
 Send to Back The selected object is displayed behind all objects within the label.
 Bring Forward The selected objected is moved forward one object. In the case of multiple objects 

selected with a multiple selection, each individual object is moved forward one object.
 Send Backward The selected objected is moved back one object. In the case of multiple objects selected 

with a multiple selection, each individual object is moved forward one object.



The Centre command (Drawing menu)
Use this command or the icons to centre objects and groups on a label. 

You can centre objects both horizontally  and vertically 

.
The object itself is centred, not its contents. For example, a text object is centred, but not the text contained within the
box. 
If a group is centred, all of the objects within the group retain their relative position to one another. The entire group is
moved.
If a multiple selection is centred, each object is centred on the label.



The Group command (Drawing menu)
Use this command or the  icon to group multiple objects in a single unit. Each object in the group retains its 
properties. All subsequent commands refer to this group as a unit and no longer its individual objects.
It is not possible to edit the group objects individually after you execute this command. To be able to edit individual 
objects, you must first ungroup them.
You can group objects that are already grouped. This creates a nested group. The previously grouped objects remain
grouped after a nested group is ungrouped.

Grouping objects



Grouping objects

1. Select the objects that you want to group by making a multiple selection.

2. Select the Group command.

3. Object properties (e.g. size, colour, line thickness, rotation, etc.) that you can change for grouped objects are valid
for all objects in the group. If objects with different properties (e.g. different fill colours) are grouped, the relevant 
fields remain blank. If you then enter a fill colour, for example, all objects in the group are displayed with this fill 
colour.

4. When you rotate a group (Format menu, Rotate command), all objects contained within this group are rotated as 
a single unit. 

5. Unlike a multiple selection, you can enlarge or reduce the group in size even if it contains a rotated object, for 
example. However, resizing is not possible if one or more of the group objects is anchored.



The Ungroup command (Drawing menu)
Use this command or the  icon to ungroup objects.
The objects from the group are restored as individual objects and can be edited independently of one another.
The previously grouped objects remain grouped after a nested group of objects is ungrouped. To be able to edit the 
individual objects independently of one another, you must repeat the Ungroup command until no more objects are 
grouped.



The Undo command (Edit menu)
Use this command to undo your editing action. 
The number of possible actions that can be undone depends on your computer’s capacity.
In some cases (e.g. when deleting large volumes of data), it is not possible to reverse an action. 
The Undo function becomes active when a file is opened or a new document is created. When a file is closed, the list
containing the last actions is deleted.
If this function is not available, the command is disabled.

Shortcuts

Toolbar:
Keyboard: CTRL+Z



The Restore command (Edit menu)
Use this command to redo actions that have been undone. The Restore function only becomes available when at 
least one action has been previously undone. If this function is not available, the command is disabled.
When a file is closed, the list containing the last actions is deleted.

Shortcuts

Toolbar:
Keyboard: CTRL+Y



The Cut command (Edit menu)
Use this command to cut the sighted area from the label and to transfer it to the clipboard. The command cannot be 
selected if an area is not highlighted beforehand.
Cutting and transferring selected areas to the clipboard deletes any data previously held in the clipboard. This means 
that the objects you have already cut are replaced by the new objects.

Shortcuts

Toolbar:
Keyboard: CTRL+X



The Copy command (Edit menu)
Use this command to copy the selected areas to the clipboard. The selected areas are not deleted from the label. The
command cannot be selected if an area is not highlighted beforehand. Copying the areas to the clipboard replaces 
any data previously held there. This means that the objects you have previously copied to the clipboard are replaced 
by the newly copied objects.
You can also copy objects by dragging them with the mouse. Select the object you want and keep the left mouse 
button pressed. Move the object to the desired position. Keep the control key (CTRL) pressed while you release the 
left mouse button.

Shortcuts

Toolbar:
Keyboard: CTRL+C



The Paste command (Edit menu)
Use this command to paste a copy of the clipboard contents. Place the cursor at the position where you want to paste
the copy. This command is not available if the clipboard is empty. You can paste the contents of the clipboard as 
many times as you want in different places. 

Shortcuts

Toolbar:
Keyboard: CTRL+V



The Tab Bar

You can use the tab bar to toggle between the labels of the opened documents.
You can either 
- click directly on the label you want (e.g. "Label 1" or "Master"), 
- click the arrow keys to jump to the first, previous, next or last label, or 
- enter the number of the label you want in the field (e.g. "1" for "Label 1" or "0" for "Master").
The tab for the master label is always displayed.
You also have the option of inserting a new label in the document by clicking the "New" icon in the tab bar. The new 
label is added as the last label.

Moving and Copying Labels
You can move labels in the tab bar by clicking on the tab of the corresponding label and keeping the left mouse 
button pressed. Move the mouse pointer to the place where you want to insert the label and release the mouse 
button.
You can also copy the selected label completely. Proceed as you would for moving a label but press the CTRL key 
before you release the left mouse button. A "+" sign appears in the mouse pointer to indicate the copying process.
The master label can neither be moved nor copied.

Moving or Copying Objects Between Labels
You can use the mouse to move and copy objects between labels.
For example, select a graphics object on Label 2 with the mouse. Keep the left mouse button pressed and point the 
mouse pointer to the new label you want in the tab bar. When you release the left mouse button, the graphics object 
is moved to the new label.
To copy an object you must keep the CTRL key pressed while you release the mouse button.



The Clear command (Edit menu)
Use this command to delete a marked object without storing it on the clipboard. You can use the Undo command to 
reverse this action.

Shortcut
Keyboard: Delete



The Select All command (Edit menu)
Use this command to mark all objects of the selected label. 

Shortcut
Keyboard: CTRL+A



The Duplicate command (Edit menu)
Use this command to duplicate a selected object.
The duplicated object is inserted immediately in the label and automatically positioned. Please be aware that the 
automatic positioning may also be outside the visible area.

Shortcut
Keyboard: CTRL+D



Copy Label
Use this command to make a complete copy of a created label.
A new label is created and all objects from the selected label are copied to the new label.
You can also copy labels with the mouse. Select the appropriate label from the tab bar and drag it with the left mouse 
button pressed to the corresponding position. Keep the control key (CTRL) pressed while you release the mouse 
button.



The Clear command (Edit menu)
Use this command to delete the active label from the document.



The Lock Content command (Edit menu)
Use this command to lock the content of a text object to continue editing it or to protect it from being edited 
inadvertently. The locked content of a text object cannot be deleted.
A check mark in the menu indicates whether the content of the text object is locked or not. 
To continue editing a locked text object, select the Lock Content command again.
You can also change this property in the Text/Graphic tab (Properties command, Format menu).



The Anchor command (Edit menu)
Use this command to anchor the position of an object on the label. An anchored object cannot be moved, rotated or 
deleted and its size cannot be changed. Both graphics and text objects can be anchored. 
A check mark in the menu indicates whether an object is anchored or not. 
To remove the anchoring from an object, select the Anchor command again.
You can also change this property in the Position tab (Properties command, Format menu).



The Links command (Edit menu)
Use this command to display the Links dialog box, where you can edit links between your document and other 
documents.
This command is not available if there are no links in your document.



The Links dialog box
You can edit embedded links in the Links dialog box.

Links
Select the link you want to edit from the list. The path of the selected link is specified under Source. The type of 
update is also specified.
You can choose the type of update under Update.

Automatic When you select the Automatic option, the link is updated continuously.

Manual When you select the Manual option, you deactivate the automatic update and the link is 
updated only when you choose to do so with the Update Now button.

Update Now To update the selected link immediately, select the Update Now button.

Open Source When the Open Source button is selected, the source file is called in the linked application.

Change Source By selecting the Change Source button you associate a link with a new location for the linked 
file in your directory (because, for example, you have moved the file).

Delete By selecting the Delete button the linked file is converted to an embedded object. Once a link 
has been deleted it cannot be reversed.



The Object command (Edit menu)
Use this command to edit an embedded or linked object. First select the object that you want to edit.
The object type appears in front of the command, for example Bitmap Object for an object from Paintbrush or a 
bitmap file, Slide Object for an object from a Microsoft PowerPoint slide etc.

Convert Converts an object to another object type. The Convert dialog box is displayed.



The Convert dialog box

Convert To The object is converted to another object type.

Activate As The object is activated as a selected object type.

Object Type The selected object type appears here.

Result The result of the conversion is displayed.

As Icon Activate this option if you want to show the object type as an icon. If you want a different icon, 
select the Change Icon button. The Change Icon dialog box is displayed.

You can obtain Help for the individual fields of the dialog box with the What’s This? function by clicking the right 
mouse button.



The Change Icon dialog box
Select either Current for the current icon, Default for the default icon or select a corresponding icon from the file 
(From File).
Select Browse to select an icon from another file.



The New command (File menu)
Use this command to create a new document in DesignPro.
Select the label template that you wish to use in the Select Template dialog box.
The Open command is used to open an existing file.

Shortcuts

Toolbar:
Keyboard: CTRL+N



The Open command (File menu)
Use this command to open an existing document in a new window. Select the desired object in the Open dialog box.
You can open multiple documents at the same time. Use the 1, 2, ... commands in the Window menu to toggle 
between the various opened documents.
DesignPro supports the WinLabel, CardMaker, Design-Your-CD and LabelPro file formats.
You can create new documents using the New command.

Shortcuts

Toolbar:
Keyboard: CTRL+O



Supported file formats
DesignPro supports the file formats of the following applications:

WinLabel 3.0 (*.zwl)
WinLabel 1.0 - 2.02 (*.wlb)
CardMaker 1.0 - 2.0 (*.car)
Design-Your-CD (*.car)
LabelPro 2.0 - 3.02 (*.lpd)



The Open dialog box
You can select the file to be opened using the following options:

File Name
Enter the file name manually or select a file from the list box. Only files that have the extension you selected in the 
Files of Type field are displayed in this box.

Files of Type
Select the type of file to be opened. DesignPro supports the following file formats:
DesignPro (*.zdp)
WinLabel 3.0 (*.zwl)
WinLabel 1.0 - 2.02 (*.wlb)
LabelPro 2.0 - 3.02 (*.lpd)
CardMaker 1.0 - 2.0 (*.car)
Design-Your-CD (*.car)

Note: With this program version of DesignPro, you can open files created by other DesignPro program versions.
The capacity to edit objects which are not supported by this program version might be limited.

Look In
Select the drive and directory for the file to be opened from the list.

Preview
A preview graphic of the selected document is displayed here, provided the document was saved with a 
corresponding preview graphic in the Save As dialog box.
You can activate or deactivate the preview function.

You can obtain Help for the individual fields of the dialog box with the What’s This? function by clicking the right 
mouse button.



.zdp file format: DesignPro
Documents that are created with DesignPro have the file extension *.zdp.



.zwl file format: WinLabel 3.0
Documents that were created with WinLabel 3.0 have the file extension *.zwl and can be opened in DesignPro.
When you have finished editing the document, you can save the file again in the new format.
It is not possible to reconvert the file.
DesignPro files cannot be read by older WinLabel versions.



.wlb file format: WinLabel 1.0 to 2.02
Files from older WinLabel versions with the file extension *.wlb can be converted by DesignPro.
The files are converted automatically to the new format. All you need to do is open the file in question. When you 
have finished editing the document, you can save the file again in the new format with the file extension *.zdp.
It is not possible to reconvert the files or save them in other (older) formats.
Please note the following variations with regard to conversion:

Document structure
In DesignPro a document consists of a master label and any number of other labels. The text and graphics objects of 
the master label are visible on all labels. The text and graphics objects of the other labels are only visible on the label 
in question. You can insert fields in the master label in order to display consecutive serial numbers or the date, for 
example.
Documents in older WinLabel versions, on the other hand, consist of a single label with the same functionality as the 
master label in DesignPro. Different label designs can only be created using "dynamic texts" in older WinLabel 
versions.
During conversion to DesignPro format all label information, with the exception of the dynamic texts, is transferred to 
the DesignPro master label.

Dynamic text
Dynamic texts are imported in the specified label as single, independent text objects. They are not visible in the 
master label.
Dynamic texts that were grouped or that were in a group with other objects are imported in the labels in question as 
single text objects. These objects are ungrouped.

Text objects
Unlike previous WinLabel versions, DesignPro does not distinguish between single line and multiple line texts. Single 
and multiple line texts are handled in exactly the same way during conversion.
It is not possible to stretch single lines of text in DesignPro. Stretched single-line text is centred during conversion. 
This may result in changes to the layout of the designed labels.
DesignPro does not support the display of justified multiple line text. Justified multiple line text is imported as left-
aligned text.

Lines
Lines are displayed with square ends in DesignPro. Lines with round ends from older WinLabel versions are also 
displayed with square ends.

lzw-compressed graphics
It is not possible to convert lzw-compressed graphics. An error message will be displayed in the label in place of the 
picture.

Databases
Older WinLabel versions supported links to dBase and ASCII databases. WinLabel 1.x and 2.x files that have 
database links are automatically linked with the dBase database when they are opened and converted. If the relevant
database file is not found during conversion of links with dBase or ASCII databases, an error message is inserted in 
the label in place of the database.
Note: This function is not available in all versions of DesignPro.

Printer settings
The printer settings (e.g. printer name, number of labels, print sequence and print output calibration) of a document 
from an older WinLabel version are not transferred during conversion to DesignPro.



.car file format: CardMaker 1.0 to 2.0
CardMaker and Design-Your-CD files with the *.car file extension can be converted by DesignPro. The file is 
converted automatically when it is opened.
The following variations must be noted in relation to conversion:

Document structure
In DesignPro, a document consists of a master label containing the text and graphics objects which are visible on all 
labels and multiple labels containing objects which are only visible on the label in question. You can insert fields in 
order to display consecutive serial numbers or the date, for example.
CardMaker documents consist of one or more labels. No master label is available. It is not possible to insert fields or 
automatic texts.
The master label is generally empty after the conversion of CardMaker files.

Justified text
DesignPro does not support the display of justified text. Justified text is displayed as left-aligned text.

Lines
Lines are displayed with square ends in DesignPro. Lines with round ends from CardMaker documents are displayed 
with square ends.



.car file format: CardMaker Design-Your-CD
CardMaker Design-Your-CD files with the file extension *.car can be converted by DesignPro. The file is converted 
automatically when it is opened.
The following variations must be noted in relation to conversion:

Directories
The icons and directory branches of the directory tree are not transferred to DesignPro during the conversion of 
directories. The text and structure of the directory are retained in the conversion.

Kerning
Kerning is not supported by DesignPro. The settings for letter spacing for round text are not retained when Design-
Your-CD files are converted.



.lpd file format: LabelPro 2.0 to 3.02
WinLabel files with the file extension *lpd can be converted by DesignPro. The file is converted automatically when it 
is opened.
The following variations must be noted in relation to conversion:

Serial numbers
The "leading blanks" function is not supported by DesignPro.

Lines
Lines are displayed with square ends in DesignPro. Lines with round ends from LabelPro documents are displayed 
with square ends.

Justified text
DesignPro does not support the display of justified text. Justified text is displayed as left-aligned text.

Text format
Strikethrough text is not supported by DesignPro.

Bar codes
DesignPro and LabelPro have different display and configuration options for bar codes.
Bar codes may be cut off in LabelPro; in DesignPro they are imported complete.
Bar code supplementals for EAN8, EAN13, UPC-A or UPC-E are not converted. The character string is imported 
complete, but the supplemental must be restored by inserting a comma at the relevant position.
In contrast with DesignPro, LabelPro supports the display of code 39 with a module width of less than 0.19 mm 
(minimum size). In this case, the imported code 39 is set to the minimum size during conversion in DesignPro.

Database
If the LabelPro file is linked with a database (*.avd), the AVD file is converted automatically to a dBase III file (*.dbf).
LabelPro databases can be converted to dBase III files using the Convert LabelPro Database command from the 
Tools menu, without having to open a LabelPro document.
Note: This function is not available in all versions of DesignPro.

Sorted database
Sorted records from a database saved with LabelPro are transferred unsorted during conversion. The records must 
be re-sorted in DesignPro using the Sort command from the Database menu.

Pictures inserted from the database
There are three options in the Avery LabelPro application for defining the size of pictures: Keep original size and 
shape (picture is inserted in original size); original shape, sized to frame (picture is adjusted to fit the frame while 
keeping the original width/height ratio); fill picture frame (picture is adjusted to fit the frame, may result in distortion).
During conversion to DesignPro, pictures inserted from a database are adjusted to fit the frame regardless of these 
specifications. This may result in distortion, which can be corrected later.



Error messages importing LabelPro files
Below are further instructions on recovering errors indicated by error messages when importing LabelPro files. Click 
on the corresponding error message.

Error opening source file.

General read error reading source file.

Incorrect source file format.

One or more picture files were not found.

Error importing database fields (Bar Code).

Error importing database fields (Text).

Error importing database fields (Picture).

Further database messages



Error opening source file.
Problem: Cannot open the LabelPro file.
Cause: The file is already open or there is a general read error.
Remedy: 1) Make sure that the file is not already open and/or that it is not being used by another application. 

Close the LabelPro file if necessary.
2) Open the file with LabelPro and save it again (check the hard disk memory and make sure that 
sufficient memory is available).



General read error reading source file.
Problem: Error reading the file.
Cause: The file is incomplete and/or faulty.
Remedy: Open the file with LabelPro and save it again (check the hard disk memory and make sure that sufficient 

memory is available).



Incorrect source file format.
Problem: Incorrect file format for file to be opened.
Cause: The file to be opened is not a LabelPro file or was saved under an unrecognised LabelPro version.
Remedy: Open the file with LabelPro 2.0 through to 3.02 and save it again.



One or more picture files were not found.
Problem: Error occurred opening a LabelPro file containing pictures.
Cause: The path specified for the image file is invalid or the image file contains an incorrect graphics format.
Remedy: 1) Open the file with LabelPro and check the path.

2) Make sure that the image file is okay and that the graphics format is supported.



Error importing database fields (Bar Code).
Problem: Error importing database fields in a bar code object.
Cause: 1) The database was not found.

2) The database was not converted.
3) The database is not linked with LabelPro file.
4) The database is faulty.

Remedy: Make sure that the path specified for the database is correct and that the database is correctly converted
during import operations; see Further database errors.



Error importing database fields (Text).
Problem: Error importing database fields in a text object.
Cause: 1) The database was not found.

2) The database was not converted.
3) The database is not linked with LabelPro file.
4) The database is faulty.

Remedy: Make sure that the path specified for the database is correct and that the database is correctly converted
during import operations; see Further database errors.



Error importing database fields (Picture).
Problem: Error importing database fields in a picture object.
Cause: 1) The database was not found.

2) The database was not converted.
3) The database is not linked with LabelPro file.
4) The database is faulty.

Remedy: Make sure that the path specified for the database is correct and that the database is correctly converted
during import operations; see Further database errors.



Database error importing LabelPro files
The following error messages could occur importing LabelPro files with databases:

The directory path for the database linked with this LabelPro file is invalid.
Problem: Database not found.
Cause: The path specified for the database is invalid.
Remedy: 1) Open the file with LabelPro and check the specified path. Make sure that the database file exists in the

specified directory. Correct the path specification if necessary or copy the database to the corresponding 
directory.
2) Copy the database file to the same directory in which the LabelPro file is saved. It is not necessary to 
enter a path in this case.

Error converting the LabelPro database.
Problem: Error converting database.
Cause: 1) The source file (*.avd) could not be opened.

2) The source file has in correct format.
Remedy: Make sure that the source file is not already open and/or that it is not being used by another application.

Make sure that the source file is a LabelPro list file (*.avd).

Error reading database.
Problem: Error reading database
Cause: General read error.
Remedy: 1) Make sure that the database (*.dbf) is not open elsewhere.

2) Make sure that the database has the correct format (dBase III).
3) Make sure that the database was correctly saved.



The Close command (File menu)
Use this command to close all windows containing the active document. DesignPro prompts you to save the changes 
to your document before closing it. 
If you close a document without saving it, all changes made since the last time you saved the document are lost. The 
Save As dialog box is displayed when closing a newly created document that has not yet been saved. You can then 
save the new document under the specified name or under a new name. 

You can also close a document by clicking the  icon.



The Save command (File menu)
Use this command to save the document under its current name and in its original directory.
The first time a document is saved, DesignPro displays the Save As dialog box so that you can name your document.
You can also select the Save As command if you wish to change the name and directory of an existing document.
If you do not specify a directory, the DesignPro file is stored in the default document directory. By selecting the 
Options dialog box (Tools menu) of the Directories tab you can change the default directory.

Shortcuts

Toolbar:
Keyboard: CTRL+S



The Save As command (File menu)
Use this command to name and save the active document. DesignPro displays the Save As dialog box so that you 
can specify a name for your document.
If you do not specify a directory, the DesignPro file is stored in the default document directory. By selecting the 
Options dialog box (Tools menu) of the Directories tab you can change the default directory.

Use the Save command to save a document under its existing name and directory.



The Save As dialog box
The following options allow you to define the name and directory under which you wish to save the active document.

File Name
Enter a new file name to save a document under a different name. If a document is being saved for the first time, 
DesignPro suggests a file name.

Files of Type
DesignPro automatically adds the .zdp extension to the name.

Save in
Select the drive and directory under which you wish to save the file.

Preview
Select whether a preview graphic is attached to the document you want to save.

You can obtain Help for the individual fields of the dialog box with the What’s This? function by clicking the right 
mouse button.



Preview Graphic
In the Open dialog box a picture is displayed as a preview of the selected document, provided this document has 
been saved with a preview graphic.
In the Save As dialog box you select whether a preview graphic is attached to the document you want to save. Saving
with a preview graphic will increase the file size slightly.
The first label including the master label of a document is displayed as a preview graphic.



The File Browser command (File menu)
Use this command to open the File Browser.



File Browser dialog box
Use this browser to search directories for DesignPro files.
Select the desired drive and directory from the list. All DesignPro files of the selected folder will be displayed in the 
preview as thumbnails.
Select a file from the preview and open the document in the same way as with the Open command. 



The Change Template command (File menu)
Use this command to change the label template.
In the Select Template dialog box you can choose the label template to be displayed in the current document. The 
print settings for this template are applied.
When you change from one template to another, all elements may not be transferred. This occurs, for example, when
the new template is smaller than the original. You will be informed of any potential problems. The Info on: Changing 
Templates dialog box is displayed. You can then cancel the operation or continue.



The Select Template dialog box
The following options are available for selecting the required label template:

Format
In the Format field you can select from product groups by clicking in the field and highlighting the required format.

Page Orientation

Here you can choose between portrait and landscape.

Item Number

Here you can search for the label template by means of the item number on the label packaging. Enter the item 
number you are looking for and click the Find button. The relevant label template is highlighted in the list of items.
The list also contains item numbers with special extensions (e.g. 0001A for the outside page of a card and 0001I for 
the inside page of a card). Some of these extensions are not displayed on the packaging.

All templates of the current product group are listed in the product list in the lower list box. Click the desired template 
with the mouse to select it.

The selected template can be seen under Preview.

Use the Edit or New buttons to edit an existing template or create a new template in the Create Template dialog box.
Note: This function is not available in all versions of DesignPro.

Click OK to open the selected label template.

You may be informed that a comparable Avery product exists for the template you have selected.
If, when changing templates, the dimensions of the old and new template differ, a message providing you with more 
information is displayed in the Info on: Changing Templates dialog box.



The Product Message dialog box
A comparable Avery product exists for the template you have selected.
For more detailed information on the two templates, click Yes. The Info on: Changing Templates dialog box is 
displayed. Both templates are displayed and you can then select the required template.
If you wish to use the template you originally selected, click No. The document is opened with the selected template.
You can disable the display of this dialog box if you wish. You can reactivate its display later in the General tab under 
the Options command in the Tools menu.



The Info on: Changing Templates dialog box
The Info on: Changing Templates dialog box displays the previous and newly selected templates in two preview 
fields. `
In addition to the template names, the number of labels, page size, page margin, label size, label spacing, corner 
radius and other information are also displayed.
Values which differ in the previous and newly selected templates are indicated.
Select the required template with the Select Template button and click OK.



The Create Template dialog box
The following options can be used to create a new template or edit an existing one. The data from the selected 
template is used.
If you want to change an existing template, the changes refer to the template that is selected in the dialog box.

Description

Item Number
Enter the item number under which you wish to save the new template here. The item number must be 
unique. If you enter an item number that already exists, a corresponding message is displayed.

Name
Enter the name under which you wish to save the new template here.

Settings

Label Shape
Select the shape for the new label from the list. You can choose from rectangle, rounded rectangle and 
circle/ellipse.
Specify the size for the rectangle and circle/ellipse in the Label Size field.

Round Corners
If you have selected Rounded Rectangle as the shape, enter the desired radius for rounding, e.g. 2 mm, in 
the field. This option is disabled for rectangle and ellipse.

Number of Labels
Enter the number of labels that the new label template is to contain. You can specify the number of labels the 
template is to contain vertically and horizontally.

Page Size
Enter the size of the page or sheet for the new label template.

Page Margin
Enter the size of the page margins here.

Label Size
Enter the size of the individual labels here.

Label Spacing
Enter the spacing between the individual labels here.

Preview
The edited template is displayed with the above settings in the preview. You can therefore review your changes 
immediately. A warning message appears if the template measurements are not conclusive (for example, if the page 
size is smaller than the label size).
Note: This function is not available in all versions of DesignPro.



The Print Preview command (File menu)
Use this command or the  icon to check on the screen how the labels you have designed will look when you print 
them.
The main window is replaced by a Print Preview window when you select this command.



Print Preview
The print preview displays the designed labels of the current document in print format.
The Print Preview toolbar allows you to scroll through the document and zoom in and out of pages before starting a 
print job.
The print preview displays the document in accordance with the current print settings.
Database fields whose contents have to be displayed with line breaks because of their length are marked in the print 
preview.



Suppressed line breaks highlighted in print preview
Database fields whose contents have to be displayed with line breaks because of their length are displayed with 
different coloured borders in the print preview, depending on the context. The following variations apply:

Blue Border: Suppress Line Breaks is disabled. The text in the database field is displayed with line breaks.

Green Border: Suppress Line Breaks is enabled. Line breaks were suppressed successfully by reducing the 
point size.

Red Border: Suppress Line Breaks is enabled. Line breaks could not be suppressed because otherwise the 
minimum point size would have been exceeded.

Note: This function is not available in all versions of DesignPro.



The Print Preview Toolbar
The following options are available in the print preview toolbar:

Print This opens the Print dialog box from where you can start a print job.

Next This action displays the next page of the printout.

Legend Click this button to display information on suppressed line breaks highlighted in the print 
preview.
Note: This function is not available in all versions of DesignPro.

Previous This action displays the previous page of the printout.

Close Clicking this button returns you to the working window.

To reduce or enlarge the print preview, you can select the desired zoom factor from the list box or enter it manually.



The Calibrate Printer command (File menu)
Use this command to adjust the label templates for the current printer.
The top and left margins are adjusted to deal with any displacement. The Print Output Calibration dialog box is 
displayed.



The Print Output Calibration dialog box

Printer
Select the Name of the printer.

Click the Print Calibration Sheet button to start printing a sheet for the purposes of print output calibration. Print one 
calibration sheet each for portrait and landscape. You can set the print area precisely with the help of the calibration
sheets.
A horizontal and a vertical scale are printed on the calibration sheet. Fold the printed calibration sheet once for 
portrait and once for landscape so that the sheet is halved by the folds.
To set the calibration, read the values for the fold and scale intersections on the horizontal and vertical scales.
The unit of the scales is millimetres. You can also measure the deviation between the fold and the scale using the 
ruler and enter values which are accurate to two fractional digits.

Calibration Data for Portrait
Enter the value readings in fields A (horizontal) and B (vertical). If the value reading is different from the default, 
overwrite the default with the new value.

Calibration Data for Landscape
Enter the value readings in fields A (horizontal) and B (vertical). If the value reading is different from the default, 
overwrite the default with the new value.

OK Click this button to apply the settings.

Cancel Click this button to cancel the action.

Clear Click this button to restore the previous setting.

Paper Size Click this button to open the Calibrate Paper Size dialog box.



The Calibrate Paper Size dialog box
In this dialog box you define the format of the calibration sheet.
You can choose between A4 (8.3 x 11.7 in.) and Letter (8.5 x 11 in.). Click OK to confirm your selection.



The Print command (File menu)
Use this command to print a document. The Print dialog box is displayed when you select this command.
In the Print dialog box you can specify the print range, the number of copies, the target printer and other print options.

Shortcuts

Toolbar:
Keyboard: CTRL+P



The Print dialog box
You can specify how the document is to be printed using the following options:

Printer
The active printer and printer connection are displayed here.
You can edit the settings for the active printer by clicking the Properties button. When printing on continuous paper  
you must select a custom paper size under Properties.

Selection
Here you can specify which labels of the document you want to print.

Copies
Here you specify how many labels or pages you want to print.

Start Position
By specifying the start position you define the position on the label sheet where printing is to start.

Options
Click this button to open the Print Options dialog box.

Print Preview
Click this button to display a preview of the page.

Click OK to start printing.



Printing on continuous paper
The format for continuous paper is not available automatically.
A custom paper size must be specified under Properties when printing on continuous paper with DesignPro under 
Windows and Windows NT. 

Printing on continuous paper under Windows

Printing on continuous paper under Windows NT



Printing on continuous paper under Windows
A custom paper size must be specified under Properties when printing on continuous paper with DesignPro under 
Windows. The format for continuous paper is not available automatically.

Creating a custom paper size under Windows

1. Select Printers under Settings in the Windows Start menu.

2. In the Printers dialog box, select the printer you want and click on Properties in the File menu. 

3. Select the Paper tab. If your printer supports custom paper sizes, click on the Custom icon.

4. Enter the settings for your custom paper size (continuous paper).
The Width refers to the width of the entire label sheet. Under Length the height of a label with respect to the 
margin, i.e. the distance between the upper edge of a label to the upper edge of the label below, is entered.

5. Click on OK.

Using the custom paper size in DesignPro

1. Select the Print command.

2. Select the Properties button in the Print dialog box.

3. Under Paper Size select the new paper size for continuous paper and click OK.



Printing on continuous paper under Windows NT
When printing on continuous paper with DesignPro under Windows NT, a custom paper size for continuous paper 
must be specified under Properties. The size for continuous paper is not available automatically.

Creating a custom paper size under Windows NT

1. Select Settings, Printers from the Windows Start menu.

2. In the File menu, click Server Properties.

3. Select the Create a New Form option in the Forms tab.

4. Enter the settings for your custom paper size (continuous paper).
The Width refers to the width of the entire label sheet. Under Length the height of a label with respect to the 
margin, i.e. the distance between the upper edge of a label to the upper edge of the label below, is entered.

5. Click Save Form.

Using the custom paper size in DesignPro

1. Select the Print command.

2. Click the Properties button in the Print dialog box.

3. Under Paper Size, select the new paper size for continuous paper and click OK.



Selection
Here you can specify which of the designed labels in the document you want to print.
You can choose the following options:

Master Only the master label is printed.

Current Selection Only the current label is printed.

All All designed labels are printed. The master label is not printed separately.

Labels The specified labels are printed.
Specify the label numbers of the labels that you wish to print. If you specify "1-3; 6", for 
example, labels 1 to 3 and label 6 are printed. The master label cannot be selected 
separately with this option.

Click the desired option to select it. If you have selected the Labels option, specify the numbers of the desired labels 
in the field.
If you have selected the All or Labels options, the master label is not printed separately. The information on the 
master label is printed with the designed labels.



Copies
Here you specify how many labels or pages you want to print.
Select the Labels or Full Page option and then specify the desired number in the Number field.
With the Labels option you define the number of copies of each label selected under Selection that are to be printed.
With the Full Page option you define the number of printed pages. Note that printing stops as soon as the last page 
is full, regardless of the start position. For example, if you enter "2" as the number of pages and select a start position
half-way through the first page, one and a half pages are printed.
The designed and selected labels are divided over the number of pages according to the way in which they are 
sorted. It can happen that different labels are printed in different numbers.
The Full Page option is disabled when a database is open. For labels that contain records, the number of copies can 
only be defined under Labels.

You can specify the print sequence or sorting in the Print Options tab.
With the options that you define under Selection and Copies you can specify whether you want to print multiple 
copies of the same label or single or multiple copies of different labels.
Select the Print Preview button to preview the printout on the screen.
There are some points to be remembered when printing labels with database fields.



The Start Position
By specifying the start position you define the position on the label sheet where printing is to start.
The start position is calculated from left to right and then line by line from top to bottom. The start position is retained 
when you change template, i.e. if a new template has a different line and column structure, the absolute value of the 
start position remains unchanged. If the specified number is too large, the start position lies outside of the template 
and an error message is displayed.
For example, if you want to print the second label in the third line of a template containing 2x3 labels, enter "6" as the 
start position. If you then change to a template containing 3x4 labels, the third label in the second line becomes the 
start position.
You can also define the start position by clicking in the template preview with the mouse.



The Print Options dialog box
You can specify how the selected labels are to be printed using the following options:

Scale
Changing the scale allows you to adjust minor distortions (mainly caused by the printer) in the printout. 

Database
Here you can specify how many records you want to print. These options are only active if a database is open.
Select Print all records if you want to print all records in a table. If you only want to print a specific range of records, 
you can define this range by entering values for Start and End.
You can define which records are to be selected for printing with Filter or Sort.
Mark the checkbox Print Tagged Records Only to print only the records having the tag field set. If a filter is active, 
only the records that match the filter conditions AND are tagged will be printed.

Note: This function is not available in all versions of DesignPro.

Printing records...
You can select the options Suppress Spaces and/or Suppress Blank Lines when printing database fields.

Suppress Spaces Select this option if the blank that follows an empty database field is to be ignored.

Suppress Blank Lines When this option is activated, if one line contains only an empty database field, this 
blank line is ignored during printing.

Print Output
Enable or disable Sort here to specify the sequence in which you wish to print the selected labels. The sorting 
sequence is represented schematically.
You can define whether or not you want to Flip, e.g. when printing slides.
OLE objects and bar codes cannot be printed as mirror images. Metafiles (*.wmf) often have only limited mirroring 
options when it comes to printing.
The Crop Marks option allows you specify whether or not label sheets are to printed with crop marks. You can select 
the preferred crop mark type from the list.
Select Suppress Line Breaks to display the contents of database fields without line breaks. In the Print tab under 
Options in the Tools menu you can define whether or not the suppression of line breaks is to be highlighted in the 
print preview. Under Minimum Point Size you can specify the minimum size to which text can be reduced.



Scale
When printing a large quantity of labels one after the other, the output may be displaced slightly with an increasing 
sheet length or width. In this case, adjust the vertical or horizontal scale in small increments (0.5 to 1%). Changing 
the scale in the range 95 to 105% is generally sufficient.
The scale has no effect on the print preview and cannot be seen there.
Changing the scale can result in slight changes to the layout, particularly in the case of texts.



Sort
The print sequence is of no significance if you have selected Master or Current Selection under Selection or if you 
wish to print only one copy of each of the various labels.
If Sort is disabled, all of the labels selected for printing are printed once in sequence. The labels are then printed a 
number of times in sequence (e.g. 123 123 123) according to the specified Number.
If Sort is enabled, the specified number of labels is printed for the first label, followed by the second, etc.(e.g. 111 222
333).
The sort function only sorts labels with different designs, not copies of labels or labels containing different records.
If you have defined the number of labels with the Full Page option, the selected labels are distributed between the 
pages in accordance with the print sequence. It can happen that the labels are printed in different numbers.
A number of different conditions apply to the sorting of labels which contain database fields and/or serial numbers.



Crop marks are only printed with printed labels. For example, if you are only printing the first four labels on a sheet of 
10, crop marks are only printed for these four labels.
The print preview display is not affected by enabling or disabling the Crop Marks option.



Sorting labels containing serial numbers
If the Sort option is enabled, the serial numbers are counted in accordance with the settings for each label printed 
until the specified end value is reached. Serial numbers cannot be sorted.
This applies regardless of the number of copies or whether or not the labels contain database fields.
If the Sort option is disabled, the serial number only increases for each subsequent copy, i.e. each differently 
designed label is first printed with the same current serial number, then a second time with a current serial number 
that has been increased by one, etc. The serial number is incremented with each subsequent copy.
If the labels contain a database field as well as a serial number, the serial number is increased with each new record, 
like the case described above, when multiple copies are printed.
If multiple copies of labels containing serial numbers and database fields are printed when sorting is disabled, the 
serial number is increased by one with the next record.



Suppress line breaks
This function reduces text objects that contain database fields by a suitable factor in the print preview and printout in 
order to prevent line breaks.
When a paragraph contains at least one database field and automatic line breaks must be inserted in this paragraph, 
the automatic point size adjustment function reduces the entire contents of the text object until a line break is no 
longer required. The various fonts are reduced proportionately (similar to zoom).
The font is reduced for the entire object and not just individual lines within a text object. For each text object and 
printed label, a check to determine whether or not the text can be output with the required formatting without line 
breaks is carried out. If the text is too long for a line in the text object, the point size is reduced until it can be 
displayed.
You can set a minimum value for the point size. When this value is reached the point size is not reduced any further.
The text object is displayed with the specified minimum point size and the text is displayed with line breaks where 
necessary.
The layout of the labels that are printed or displayed in the print preview may differ from the label design in some 
cases. This is caused by the reduction of individual text objects and of each printed label.
Note: This function is not available in all versions of DesignPro.



Printing multiple copies of labels
1. If you want to create one label only, you can either design the master label or any other label.

2. Select the Print command and set the print options in the Print dialog box..

3. In the Selection field select the label to be printed. Select Master if you have designed the master    
label,Current Selection for the current label, or enter the number of the designed label under the Labels 
option. Select the Full Page option in the Copies field if you want to print a full page with the designed label. If 
you only want to print the label once, select the Labels option and enter "1" under Number.

4. Select the Full Page option in the Copies field if you want to print a full page with the designed label. If you only
want to print the label once, select the Labels option and enter "1" under Number. If you want to start printing at
a specific point on the page, enter the start position.

5. If you want to start printing at a specific point on the page, enter the start position

Printing different labels...



Printing different labels
1. When designing several different labels, insert the desired information on each individual label. If specific 

objects are to appear on all labels, insert them in the master label.

2. Select the Print command and set the print options in the Print dialog box. 

3. In the Selection field, select the designed labels that you wish to print (e.g. 1–3; 5) or select All. The master 
label is not printed separately in either case.

4. You can print labels more than once. If you wish to print each label twice, for example, select the Labels option 
in the Copies field and enter "2" under Number. If you wish to print full pages of the labels, select the Full Page 
option and enter the number of pages. The Full Page option is disabled if a database is open. The selected 
labels are ordered on the pages according to the selected print sequence. Occasionally, the number of labels 
printed is not the same. You can prevent this from occurring by changing the start position accordingly. If you 
want to start printing at a specific point on the first page, enter the start position.

5. If you want to start printing at a specific point on the first page, enter the start position.

6. If you wish to print the labels in sequence, select the Sort option in the Print Options dialog box. If Sort is 
disabled, the labels are first printed in sequential order. This is repeated according to the number of copies 
selected (for example 123 123, etc.). If Sort is enabled, the same label is printed multiple times before the next 
label is printed. If, for example, you select to print three copies of the label, the first label is printed three times, 
the second then printed three times and so on (such as 111 222 333). Sorting only refers to labels with different 
designs, not copies.

Printing multiple copies of labels...



Printing records
1. Open the required database with the Open command in the Database menu.

2. Insert the required database field in a text object on the master label using the Insert Field command in the 
Database menu. You can insert multiple database fields from a database table in different text objects on the 
master label. Use the Display Field Contents command to specify whether the field names of the inserted fields or
the field contents are to be displayed on the screen.

3. Design one or more labels. You can format text objects containing database fields in exactly the same way as 
normal text objects. Use the commands from the Format menu for this purpose (e.g. the Properties command).

4. If you wish to print specific records, you can select them using the Filter or Sort functions.

5. Select the Print command in the File menu and enter the print options in the Print dialog box.

6. Use the Options button to open the Print Options dialog box. Under Database, specify the number of records you
wish to print. You can either print All records; or you can specify the Maximum Number of records that you wish 
to print.

7. Use the Selection and Copies options to specify which labels and how many of them you wish to print.

Examples for printing labels containing database fields

Note: This function is not available in all versions of DesignPro.



Printing labels containing database fields
When printing labels containing database fields, the number of records (Print Options dialog box) must be noted in 
addition to the number of labels (Print dialog box).
The number of copies for labels containing records can only be defined under Labels. The Full Page option is 
disabled if a database is open.
The number of labels specifies how many copies of identical labels of the same design (with the same database field 
contents) are to be printed.
The number of records specifies how many labels of the same design with different database field contents there 
are.

Examples:
One label design:
Each label is to be printed once
Two copies of each label are to be printed

Multiple label designs:
Each of the label designs is to be printed once
Two copies of each of the label designs are to be printed



Examples for printing labels containing database fields:

One label design:
Each label is to be printed once
The print settings in the Print dialog box are: "Current Selection", "Labels 1"
You open a database containing 20 records, for example. If you create a master label design which contains 
database fields and select the "Print All Records" option under Database in the Print Options dialog box, 20 labels 
(1 label design x 20 records) are printed with these settings.
Sorting is not possible when there is only one label design; the Sort option is disabled in this case.
Two copies of each label are to be printed

Multiple label designs:
Each of the label designs is to be printed once
Two copies of each of the label designs are to be printed



Examples for printing labels containing database fields:

One label design:
Each label is to be printed once
Two copies of each label are to be printed
2 copies are to be printed with the following print settings: "Current Selection", "Labels 2"
If you have created a label design without database fields, two identical labels are printed with these settings.
You open a database containing 20 records, for example. If you create a master label design which contains 
database fields and select the "Print All Records" option under Database in the Print Options dialog box, 40 labels 
(1 label design x 20 records x 2 copies) are printed with the same settings as above.

Multiple label designs:
Each of the label designs is to be printed once
Two copies of each of the label designs are to be printed



Examples for printing labels containing database fields:

One label design:
Each label is to be printed once
Two copies of each label are to be printed

Multiple label designs:
Each of the label designs is to be printed once
2 labels (L1 and L2) are designed in the example below. The print settings in the Print dialog box are: "All", "Labels 
1", i.e. each label is to be printed once.
In the case of 2 labels with no database fields, exactly 2 labels (2 label designs x 1 copy) are printed with these 
settings.
You open a database containing 20 records, for example. If you create a master label design which contains 
database fields and select the "Print All Records" option under Database in the Print Options dialog box, 40 labels 
(2 label designs x 20 records) are printed with these settings.
If the Sort option is disabled, both labels (L) are printed with the first record (R), followed by both labels with the 
second record, etc.
(L1 R1, L2 R1, L1 R2, L2 R2, L1 R3,..., L1 R20, L2 R20).
If Sort is enabled, the first label is printed with records 1 to 20, followed by the second label with records 1 to 20, etc.
(L1 R1-R20, L2 R1-R20).
Two copies of each of the label designs are to be printed



Examples for printing labels containing database fields:

One label design:
Each label is to be printed once
Two copies of each label are to be printed

Multiple label designs:
Each of the label designs is to be printed once
Two copies of each of the label designs are to be printed
2 copies are to be printed with the following print settings: "Current Selection", "Labels 2"
In the case of 2 labels with no database fields, exactly 4 labels (2 label designs x 2 copies) are printed with these 
settings.
You open a database containing 20 records, for example. If you create a master label design which contains 
database fields and select the "Print All Records" option under Database in the Print Options dialog box, 80 labels 
(2 label designs x 20 records x 2 copies) are printed with these settings.
If the Sort option is disabled, the labels are printed unsorted and then printed again a second time, i.e. both labels 
are printed with records 1-20 and are then printed again a second time.
((L1 R1, L2 R1, L1 R2, L2 RS2, L1 R3,..., L1 R20, L2 R20) x 2 copies).
If Sort is enabled, the first label (L1) is printed twice with records 1 to 20 (R1-R20). The second label design (L2) is 
then printed twice with records 1-20, i.e. the labels are sorted (all L1 together, all L2 together), and the copies are 
printed in sequence.
((L1 R1-R20) x 2 copies, (L2 R1-R20) x 2 copies).



The Print Progress dialog box
The Print Progress indicator is displayed while DesignPro sends the output to the printer. The page number 
indicates the progress of the print job.

Select Cancel to cancel the print job before it starts.



Printer Setup
Click on the Properties button to define the printer, paper size and paper source and format for printing. The 
Properties dialog box is displayed.
You can obtain Help for the individual fields of the dialog box with the What’s This? function by clicking the right 
mouse button.



The Send Message command (File menu)
Use this command to send the active document via electronic mail.
When you select this command an electronic mail window linked with the active document is opened. Here you can 
fill out the fields To:, Subject: etc. and add a message text if you wish. 
When you have finished, click the Send button to send the prepared message.



The Properties command (File menu)
Use this command to display the document properties. The Document Properties dialog box is displayed.
In the Document Properties dialog box you can view and edit file information in the File Info tab.
Statistical file information is displayed in the Statistics tab.



The File Info tab
You can enter or view information on the current document in the File Info tab.

Application Displays the name of the application.

Author Displays the name of the author. You can change this name if you wish.

Keywords Enter the words that you wish to use when searching for a particular file.

Comments Enter the comments that you wish to use when searching for a particular file.

Title Enter the title that you wish to use when searching for a particular file. The title can be different from 
the file name.

Subject Specify the subject of a file. Use this property to group files together so that you can find all files with 
the same subject.

Template Identifies the template linked with the file.



The Statistics tab
The Statistics tab contains information on the document contents and file access.



The User Registration dialog box
The User Registration dialog box is displayed when DesignPro is started on a computer that is accessed by several 
users.
Enter your user name in the box and click OK. The user name is used as the name of the author in the document 
Properties.
If you do not enter a user name, you can close this dialog box by clicking Cancel and continue working with 
DesignPro.
You can change the user name or enter it at a later stage using the Options command in the Tools menu.



The 1, 2, 3, 4 commands (File menu)
Use the numbers and file names listed at the end of the File menu to open the last four documents that you closed. 
Select the number of the document to be opened.



The Exit command (File menu)
Use this command to exit your DesignPro session. You can also exit the application by selecting the Close command
from the system menu. DesignPro asks you if you want to save your documents before closing them.

Shortcuts
Mouse: Double-click on the application’s system menu.
Keyboard: ALT+F4



The Size command (System menu)
Use this command to change the size of the active window by pressing the ARROW KEYS.

1. Press one of the ARROW KEYS (one of the keys LEFT, RIGHT, UP or DOWN) to move the pointer to the required 
margin.

2. Press an ARROW KEY to move the margin.

3. Press ENTER when the window has reached the required size.

Note: This command is not available when the window is displayed as a full screen.

Shortcut
Mouse: Drag the sizing handle to the corners or the margins of the window.



The Move command (System menu)
Use this command to display a crosshair which you can use to move the active window or dialog box by pressing the 
ARROW KEYS.

Note: This command is not available when the window is displayed as a full screen.



The Minimise command (System menu)
Use this command to minimise the DesignPro window to an icon.

Shortcuts
Mouse: Click the minimise button in the title bar.



The Maximise command (System menu)
Use this command to maximise the active window so that it uses all the space available.

Shortcuts
Mouse: Click the maximise button in the title bar or double-click the title bar.



The Next command (System menu)
Use this command to switch to the next open document window. DesignPro displays the windows in accordance with 
the sequence in which you opened them.

Shortcut
Keyboard: CTRL+F6



The Previous command (System menu)
Use this command to switch to the previous open document window. DesignPro displays the windows in accordance 
with the sequence in which you opened them.

Shortcut
Keyboard: SHIFT+CTRL+F6



The Close command (System menu)
Use this command to close the active window or dialog box.

A double-click on the  system menu box has the same result as selecting the Close command.

Note: If multiple windows are open for a single document, the Close command from the document system menu only 
closes a single window. To close all windows at once, you can use the Close command from the File menu.

Shortcuts
Keyboard: CTRL+F4 closes a document window.

ALT+F4 closes DesignPro.



The Restore command (System menu)
Use this command to restore the active window with the same size and position that it had before the Maximise or 
Minimise commands were selected.



Title Bar
The title bar of the main window contains the name of the application and of the current document.
You can move the window by dragging the title bar. Dialog boxes can also be moved by dragging their title bar.
The title bar contains the following elements:

System menu button for the application
Application name
Document name
Minimise button
Maximise or restore button
Close button



Scroll Bars
Scroll bars are displayed on the right and bottom margins of the document window. The scroll bar buttons in the scroll
bars indicate the vertical and horizontal position within your document. You can use the mouse to scroll to other 
sections of your document.



No Help available
There is no Help available for this area of the window.



No Help available
There is no Help available for this topic.



The Character command (Format menu)

Use this command or the Text toolbar  icons to edit
the format of the selected text. This command and the icons only become available when a text object is selected.
The Font dialog box is displayed.



The Alignment command (Format menu)
Use the following commands or icons to align the text in a text object. These command and the icons only become 
available when a text object is selected.

Left Left aligns text in a text object.

Centred Centres text in a text object.

Right Right aligns text in a text object.

Top Aligns the text to the upper edge of the text object.

Middle Aligns text vertically and in the middle of the text object.

Bottom Aligns the text to the bottom edge of the text object.

If no paragraph is selected, the text alignment refers to the entire text in the text object. Selected sections of text can 
be aligned individually to the left, to the right, or can be centred. Within a text object, each paragraph can be aligned 
differently - to the left, to the right or centred.
Top, Middle and Bottom alignments can only be applied to the entire text.
The plaintext in bar codes can also be aligned using the Left, Centred, Right, Top and Bottom commands. There 
are restrictions with regard to the use of these commands, depending on the bar code type.



The Line Spacing command (Format menu)
Use this command to change the line spacing. This command only become available when text is selected. The Line 
Spacing dialog box is displayed.



The Line Spacing dialog box
You can set the line spacing in the Line Spacing dialog box.

Line Spacing Select the line spacing by opening the field with a mouse click and selecting the option you want. 

Units In the Units box, manually enter the unit you require.

Line spacing refers to the paragraph where the cursor is currently positioned. If no paragraph is selected, the line 
spacing is applied to the entire text in a text object. You can assign different line spacing to different paragraphs.



The Fill Colour command (Format menu)
Use this command or the icon to change the fill colour of an area. The Edit Colours dialog box is displayed.

This command is available for rectangles, ellipses, squares, polygons and bar codes.
Set the background colour of the text object with the fill colour. To activate the background colour, the No Colour 
check box must be disabled in the Edit Colours dialog box.



The Edit Colours dialog box
In the Edit Colours dialog box you can define which fill colour or line colour you want to assign to a selected object. 
You also have the option of defining whether or not an object should be assigned No Colour.

You can obtain Help for the individual fields of the dialog box with the What’s This? function by clicking the right 
mouse button.



The Fill Pattern command (Format menu)
Use this command or the  icon to fill an area with a pattern.
The Fill Pattern dialog box is displayed.
This command is available for rectangles, ellipses, polygons and text objects.



The Fill Pattern dialog box
You can define a fill pattern for a selected object in the Fill Pattern dialog box. You can also select the background 
colours and the fill pattern.

You can obtain Help for the individual fields of the dialog box with the What’s This? function by clicking the right 
mouse button.



The Line Colour command (Format menu)
Use this command or the  icon to change the line colour of a selected object. The Edit Colours dialog box is 
displayed.

This command is available for graphics objects and text objects.
Set the colour of the text object border with the line colour. To activate the line colour, the No Colour check box must
be disabled in the Edit Colours dialog box.

You can obtain Help for the individual fields of the dialog box with the What’s This? function by clicking the right 
mouse button.



The Line Thickness command (Format menu)
Use this command or the  icon to change the line thickness. This command is available for graphics objects and 
text objects.

The Line Thickness dialog box is displayed.



The Line Thickness dialog box
In the Thickness  area you can use the mouse to select the thickness you want from the predefined line thicknesses.
You can also manually enter the desired line thickness in the Custom area using the scroll bar or by entering the line 
thickness directly. 



The Round Corners command (Format menu)
Use this command to format rectangles and text objects with rounded corners. 
The Round Corners dialog box is displayed.



The Round Corners dialog box
In the Round Corners dialog box, you can manually enter the radius that the rounded corners of the selected 
rectangle or text object should have.



The Rotate command (Format menu)
Use this command or the  icon to rotate a selected object. The Rotate dialog box is displayed.



The Rotate dialog box
In the Rotate dialog box you define the degree to which the selected object is to be rotated.
Bar codes and graphics can only be rotated to 0°, 90°, 180° and 270°.

Angle of Rotation
Choose between four different angles (0°, 90°, 180°, 270°) to which you want to rotate the object or enter the exact 
degree between 0° and 360° in the Exact area. If you enter 30° for example, the axis of the object is aligned to 30°.
When you have entered all the changes, click OK.



The Snap to Ellipse command (Format menu)
Use this command to snap a text to a round text object. The Round Text dialog box is displayed.



The Round Text dialog box

Angle
Choose between four different angles (0°, 90°, 180°, 270°) to which you want to rotate the text or enter the exact 
degree between 0° and 360° in the Exact area. If you enter 30° for example, the axis of the object is snapped to 30°.

Alignment
Select Alignment to determine whether the text should appear to the right, left or centre of the selected angle. If 
you select centred and 90° for example, the centre of the text is at 90°. If you select left, the text ends at 90° and if 
you select right, the text begins at 90°.

Flip
By activating or deactivating the Flipped Over check box, you can flip the text 180°. The text direction then changes 
from clockwise to anti-clockwise.
When you have entered all the changes, click OK.



The Field Parameters command (Format menu)
Use this command to format fields. You can use this command to edit the Serial Number or Date & Time fields that 
you inserted in the Insert menu.
Select the serial number or date field in the text object by double-clicking and select the corresponding Serial Number
or Date & Time command under the Field Parameters command. The dialog box for editing the field appears.

Note: This function is not available in all versions of DesignPro.



The Bar Code Parameters command (Format menu)
Use this command to format bar codes. The Bar Code dialog box is displayed.
The Bar Code command in the Drawing menu is used to insert bar codes.

Note: This function is not available in all versions of DesignPro.



The Bar Code dialog box

Bar Code
Select the type you want by clicking with the mouse on the list of Bar Code Types.

Parameters
You can activate or deactivate the options for the layout and check digit calculation of the bar code.
Activate Display Plaintext if the unencoded plain text is to be inserted under the bar code. You can align the plaintext
of a bar code in the bar code field by selecting the AlignmentHID_FORMAT_TEXT command from the Format menu. 
For example, you can specify whether the plaintext is to appear above or below the bar code. There are restrictions 
with regard to the alignment of the plaintext, depending on the bar code type.

Adjust Size
You can adapt the size of the displayed bar code to the size of the previously inserted bar code field by using Adjust 
Size. In this case, the Options button is deactivated.
If Adjust Size is not activated, the bar code is displayed in the default size ratio. Use the Options button to open the 
Bar Code Options dialog box where you can define settings for the size ratios of the bar code.

When you have entered all the changes, click OK.

Note: This function is not available in all versions of DesignPro.



Calculating and displaying check digits
You can use the Calculate Check Digit and Display Check Digit options to define whether a check digit is to be 
calculated and/or displayed for a bar code with check digit calculation.

Calculate Check Digit
Activate this option to calculate a check digit from the string entered.
The check digit is coded accordingly.
If Calculate Check Digit is deactivated, only the string entered, and not the check digit, is coded.

Display Check Digit
Activate this function to display the check digit in plaintext. 
If Display Check Digit is deactivated, only the string without the check digit is displayed in plaintext.
To use Display Check Digit, Display Plaintext must be activated.

Further Information on Bar Codes With Mandatory Check Digit Calculation...



For a check digit calculation, the check digit is the last digit or place of a bar code string. The calculation proceeds 
according to rules which are defined by the selected bar code type.



Calculating and displaying check digits for bar codes with mandatory check digit calculation
In the case of bar codes with mandatory check digit calculation (e.g. Code 128, EAN and UPC codes), if you want to 
enter a complete string including check digits, Calculate Check Digit must be deactivated. With Display Check 
Digit you can specify whether or not the check digit you entered is displayed in plaintext.
In the case of bar codes with mandatory check digit calculation, if you only enter the string (without check digits), 
Calculate Check Digit must be activated. The check digit must be calculated for the bar code to be complete. With 
Display Check Digit you can specify whether or not the calculated check digit is displayed in plaintext.
The bar code types with mandatory check digits are described in Bar Code Types.



The Bar Code Options dialog box
You can configure the settings for bar code size ratios in the Bar Code Options dialog box.
The look-and-feel of the dialog box depends on the selected bar code type.

Bar Code Options for:
EAN codes
EAN 128
UPC codes
Codes 2/5, 39, 128 and Bar Code

Note: This function is not available in all versions of DesignPro.



Bar code options for EAN Codes
The width to height ratio is set for EAN 8 and 13 codes. The size of the bar code is specified by standard sizes with 
fixed zoom factors.
Select the size you want from the list of bar code sizes, SC0 to SC9. SC2 is the nominal size. The zoom factors are 
specified in each case.
You can also enter the zoom factors manually. However, it is recommended to use the bar code standard sizes, SC0 
to SC9.



Bar code options for UPC Codes
The width to height ratio is set for UPC-A and UPC-E codes. The size of the bar code is specified by defined zoom 
factors.
Select the size you want from the list. You can also enter the zoom factors manually.



Bar code options for EAN 128
You can manually enter the zoom factor you want in the Size for EAN 128 area for the EAN 128 code. The zoom 
factor must be between 0.25 and 1.2.



Bar code options for codes 2/5, 39 and 128 and bar code
For the 2/5, 39 and 128 codes and bar code, the size of the bar code is determined by specifying the module width 
and module ratio.
The size of code 128 can only be defined by the module width. The remaining options are not activated.
The module width is the width of the narrowest element in the bar code and is specified in millimetres.
The module ratio is the width ratio between a broad element and a narrow element. The module ratio can vary 
between 2:1 and 3:1. The nominal value is a ratio of 3:1. You can define the module ratio from the list or manually.
For code 39 bar codes, the start and stop characters (*) are not displayed by default in the plaintext. Enable this 
option if you want to display the start and stop character (*) in plaintext.



Bar code types
DesignPro supports a range of current bar code types.

EAN 8
EAN 13
EAN 128
Code 128 (Type A, B, C)
Code 39
2/5 Standard (Industry)
2/5 Interleaved (overlapping)
Bar Code
UPC-A
UPC-E
POSTNET

You can select the bar code type in the Bar Code dialog box.



EAN (European Article Numbering)
EAN codes belong to the article number codes. They are numeric and have a fixed number of characters.

EAN 8

Character set 10 digits (0-9)

Start/stop character 1 start/stop character. These are automatically inserted.
1 separator

Self-checking yes

Check digit calculation yes, 1 check digit

Number of characters fixed, 8 places.
7 or 8 digits must be entered. When 7 digits are entered, the check digit must be 
calculated.

EAN 13

Character set 10 digits (0-9)

Start/stop character 1 start/stop character. These are automatically inserted.
1 separator

Self-checking yes

Check digit calculation yes, 1 check digit

Number of characters fixed, 13 places
12 or 13 digits must be entered. When 12 digits are entered, the check digit must be 
calculated.

You can select the bar code type in the Bar Code dialog box.



EAN 128 (European Article Numbering)
EAN 128 is an alphanumeric article number code with special characters.

Character set 128 ASCII characters
4 special characters

Start/stop character 3 start characters
1 stop character. These are automatically inserted.

Self-checking yes

Check digit calculation none
A check digit is not mandatory, but should be used. To use a check digit activate the check 
digit calculation function in the Bar Code dialog box.

Number of characters variable

You can select the bar code type in the Bar Code dialog box.



Code 128
Code 128 is an alphanumeric code with special characters. 3 character sets (A, B, C) are available. The character set
that gives the shortest bar code is automatically selected and the corresponding start character prefixed.

Character set 128 ASCII characters
4 control characters
4 special characters

Start/stop character 3 start characters
1 stop character. These are automatically inserted.

Self-checking yes

Check digit calculation yes, 1 check digit

Number of characters variable

You can select the bar code type in the Bar Code dialog box.



Code 39
Code 39 is an alphanumeric code with special characters.

Character set 10 digits (0-9)
26 uppercase letters (A-Z) 
6 special characters (-.$/+%)
blanks                 
The extended Code 39 with 128 ASCII characters is also available.

Start/stop character 1 start/stop character. These are automatically inserted.

Self-checking yes

Check digit calculation none
A check digit is not mandatory, but should be used. To use a check digit activate the check 
digit calculation in the Bar Code dialog box.

Number of characters variable

You can select the bar code type in the Bar Code dialog box.



Code 2/5
2/5 codes are numerical codes with variable lengths.

2/5 Standard (Industry)

Character set 10 digits (0-9)

Start/stop character 1 start character
1 stop character. These are automatically inserted.

Self-checking yes

Check digit calculation none
A check digit is not mandatory, but should be used. To use a check digit activate the check 
digit calculation function in the Bar Code dialog box.

Number of characters variable

2/5 Interleaved (overlapping)

Character set 10 digits (0-9)

Start/stop character 1 start character
1 stop character. These are automatically inserted.

Self-checking yes

Check digit calculation none
A check digit is not mandatory, but should be used. To use a check digit activate the check 
digit calculation function in the Bar Code dialog box.

Number of characters even

When an uneven number of characters is entered 0 is automatically prefixed.

You can select the bar code type in the Bar Code dialog box.



Bar Code

Character set 10 digits (0-9) 
6 special characters (-$:/.+)

Start/stop character 4 start/stop characters (ABCD)

Self-checking yes

Check digit calculation none
A check digit is not mandatory, but should be used. To use a check digit activate the check 
digit calculation function in the Bar Code dialog box.

Number of characters variable
One of the 4 start/stop characters (A, B, C, D) must be entered as the first and last 
character. Lowercase letters (a, b, c, d) are automatically converted to uppercase. A, B, C 
and D should not be contained in the string.

You can select the bar code type in the Bar Code dialog box.



UPC (Universal Product Code)
UPC codes belong to the numeric article number codes.

UPC-A

Character set 10 digits (0-9)

Start/stop character 1 start/stop character. These are automatically inserted.
1 separator

Self-checking yes

Check digit calculation yes, 1 check digit

Number of characters fixed, 12 digits 
11 or 12 digits, including check digits, must be entered. When 11 digits are entered, the 
check digit must be calculated.

UPC-E

Character set 10 digits (0-9)

Start/stop character 1 start/stop character. These are automatically inserted.

Self-checking yes

Check digit calculation yes, 1 check digit

Number of characters fixed, 8 digits (6 active characters and 1 boundary character at the beginning and end)
6 digits exactly must be entered. The system digit in the first position is always "0" and is 
automatically prefixed.

You can select the bar code type in the Bar Code dialog box.



POSTNET (Postal Numeric Encoding Technique)
POSTNET is a numeric code for encoding zip codes.

Character set 10 digits (0-9)

Check digit calculation none
It is not possible to calculate a check digit. 

Number of characters Three different lengths are possible:
5 digits (32 bars) 
9 digits (52 bars) or
11 digits (62 bars) 

Non-numeric entries (letters and/or special characters) are ignored when generating the bar code. This feature 
allows, for example, address lines with street names and zip codes to be added, whereby only the zip code is 
encoded in the POSTNET code.
The size of the bar code cannot be changed.
You can select the bar code type in the Bar Code dialog box.



The Properties command (Format Menu)
Use this command to display the properties of a selected object. You can edit these properties in the Format dialog 
box.



The Format dialog box
You can view and edit the format properties of a selected object in the Format dialog box. The following tabs are 
available:

Size
Position
Lines and Colours
Rotation
Text/Picture

You can also change the size and position of a selected object directly in the object by moving the handle or the 
object accordingly with the mouse.



The Size tab
You can define the size of the marked object here. Changes to size are automatically implemented and displayed.

Size
Change the units here for Width and Height. Radius and Corner Radius are enabled/disabled depending on the 
type of the selected object. You can use the scroll bar or enter the values you want manually.
Millimetres (mm) are used as the default unit of measurement. You can enter either centimetres (cm), inches (in) or 
points (pt). The entered sizes are automatically calculated and displayed in millimetres.

Scale
You can modify the width and height of an object here using percentages.
If the selected object is a picture or bitmap you can display the absolute values entered under Size as percentage 
values by activating the Relative to Original Size option. You see the percentage scaling of the selected graphics 
object in relation to the originally specified size of the graphic under Original Size.
This option has no effect on the scaling of the graphics objects on the label.

Original Size
This area is only activated if a graphic or bitmap is selected. The original size of the graphics object is displayed here.
Select the Reset button to reset the scaling of the selected graphics object to the original size. The original size 
cannot be edited.



The Position tab
In the Position area, the horizontal and vertical position of the selected object is specified. You can either use the 
scroll bar or enter the values manually.
By activating Anchor Object you can protect objects from being moved and/or from changes to their size. This 
setting can also be defined via the Anchor command in the Edit menu.



The Lines And Colours tab
You can edit the properties of lines, areas, text objects and bar codes with the options on this tab.

Lines
In the Lines area you can select the Line Colour and Line Thickness by clicking with the mouse to open the field 
and selecting the option you want. In the Custom area you can enter the line thickness manually. If you don’t want 
the lines to be visible, activate No Colour.

Areas
You can select the Fill Colour of objects here by opening the field and selecting the colour you want. Or activate the 
No Colour check box if you don’t want the object to have a fill colour.



The Rotation tab
In the Angle of Rotation area, you specify the angle by which the selected object is to rotate. You can change the 
values by selecting the predefined angle or by manually entering an angle in the Exact area or by using the scroll 
bar.



The Text/Picture tab

Text Margin
Define the text margin here by entering the values, either manually or with the scroll bar, in the areas Left, Right, 
Top, Bottom.

Picture:
By activating the Save Picture As Reference function you can insert the selected graphic in a document memory-
efficiently. The picture also appears on the screen, however it is only stored by entering the path and file name. Use 
the Browse button to open the Save Picture As Reference dialog box, in which you can select the graphics file you 
want. If the path or file name given as a reference is not found when opening the document, the document is opened 
without the specified picture and an error message appears.
If you are inserting pictures from a database, you can find and select the directory from which the pictures are to be 
taken by activating Specify Path Name with the Browse button. This function only becomes available when a 
database is opened.

Activate the Automatically Adjust Size Of Text Object check box if you want to have the size of the text object 
automatically sized to fit the entered text. When the text is entered, the height of the text object is extended 
automatically if the text entry is bigger than the text field. This function is enabled by default.
By activating Lock Contents you can prevent text objects from being edited, like using the Lock Content command in
the Edit menu.



The Save Picture As Reference dialog box
In the Save Picture As Reference dialog box, select the picture whose path and file name are to be used as a 
reference.



The Automatically Adjust Size of Text Object function is activated by default.
If the height of the text object is afterwards manually made smaller than the text input, the Adjust Size function is 
automatically disabled. The text object is no longer auto-adjusted to the text input and truncates the text. The text is 
not lost, however.
The Automatically Adjust Size of Text Object function can be reactivated with the Properties command.



The DesignPro Help command (Help menu)
Use this command or the  icon to display the contents of the Help topics.
The Help topics can be accessed via the tabs.

Contents
Index
Find.

Press the F1 key in the Help window for more information on using Help.



The Contents tab

1. All of the program menus are displayed in the list box. To see the sub-topics of the current menu, click on the 
menu you want and select the Open button.

2. Instead of a book icon in front of the menu, an open book appears and all of the program sub-topics are listed 
underneath. Select the sub-topic for which you require Help and click Display.

Press the F1 key in the Help window for more information on using Help.



The Index tab
You can search for terms alphabetically here.

1. In the upper list box, enter the first letter of the word you want to find. All terms with this initial letter appear 
automatically in the lower list box.

2. Click on the entry you want and then click Display.

Press the F1 key in the Help window for more information on using Help.



The Find tab

Rebuild
When you call the Find function for the first time (or if you want to rebuild it), the Find Setup wizard appears.

Find
If the Find function is already available, the Find tab is displayed with several text boxes.

1. In the first text box enter the words you want to find. Use Clear to delete the entry in the text box.

2. In the second text box, all terms that correspond to your entry in the first text box are displayed. Select one or 
more suitable words to narrow the search.

3. The topics found for the search terms are displayed in the third text box. You can now select the topic you want 
and click Display.

You can also define options for the search.



The Find Setup wizard

1. On the first page select whether you want to minimise the database, maximise the search capabilities or 
customise the search capabilities and then click the corresponding button. 

2. If you have selected Customise Search Capabilities, several pages appear on which you can define the find 
program more specifically. 

3. On the second page, select the Help files that are to be included in the list.

4. The Finish button appears on the last page. The word list is now generated.



The Find Options dialog box
Use the Options button to open the Find Options dialog box. 

1. Here you can define more closely the criteria for the search by enabling or disabling different buttons. 

2. The selected options appear in the field in the lower right of the tab. 

3. Use the Files button to select the files that are to be browsed.

You can obtain Help for the individual fields of the dialog box with the What’s This? function by clicking the right 
mouse button.



The What’s This? command (Help menu)
Use this command or the  icon to display the What’s This? Help for a specific function.

By clicking on program elements with the What’s This? mouse pointer  you can obtain more detailed 
information about the function. 
Press the F1 key in the Help window for more information on using Help.



The User Manual command (Help menu)
Use this command to view the User Manual for DesignPro in the Acrobat Reader. The path of the User Manual is 
displayed in the Directories tab.

Note: This function is not available in all versions of DesignPro.



The Avery on the Web command (Help menu)
Use this command to go to the Avery web site. The web page is displayed using your system's default browser.



The About command (Help menu)
Use this command to display the copyright details and the version number of your copy of DesignPro.



If you need help on a topic or program element…

... just have a look in the Help Topics contents or index in the Help menu.
You can also use What’s This? in the Help menu or you can select a button or a menu command in the toolbar to get
Help on the selected program element.
Or you can select a menu command, button or dialog box and then get Help by pressing the F1 key.
Press the F1 key in the Help window for more information on using Help.



The Label command (Insert menu)
Use this command or the icon in the tab bar to insert a label in the document. The new label is added as the last 
label.



The Serial Number command (Insert menu)

Use this command or the  icon to insert a serial number in a text object. 
When you select a text object, the serial number is inserted in the object. Otherwise, a new text object is created and 
the serial number inserted automatically there.
The Serial Number dialog box is displayed.
You can edit serial number fields at any time by selecting the Field Parameters command from the Format menu.

Like all other automatic fields, serial numbers can only be inserted in the master label.
You can display the contents of a field, e.g. the serial number of a label, by selecting Print Preview from the File 
menu.

Note: This function is not available in all versions of DesignPro.



Serial Number dialog box
In the Serial Number dialog box you can define the format of the serial number. You can choose from the following 
options:

Serial Number Type Choose between a numeric (1, 2, 3, ...) and an alphabetic serial number
(Aaa, Aab, Aac, ...) by selecting the relevant radio button.

Serial Number Range Enter a Start Value, an End Value and the Increment. Note that 
counting is always from the start value to the end value. For example, if you 
specify 1 as the start value, 10 as the end value and 1 as the increment, counting
will automatically proceed in the sequence 1, 2, 3, ..., 10. With an increment of 2,
counting is in the sequence 1, 3, 5, ..., 9. If you specify a start value of 10 and an 
end value of 1, you must not specify a negative increment. When the end value 
is exceeded, the serial number is no longer output, i.e. it is printed as an empty 
character string.
You can also specify whether or not the serial number is to be displayed with 
leading zeros by checking or unchecking the relevant check box. If Leading 
Zeros is enabled, the Number of Spaces must be specified. If the serial number
is displayed with leading zeros, the corresponding number of zeros is displayed 
for three-digit numbers as well as for numbers which do not contain three digits, 
e.g. 001,002, ..., 010, etc.

Current Serial Number Value Here you can choose whether or not you wish to save the current serial number 
value. When this option is enabled, the current serial number of the last label 
printed is saved. The next time the document is opened, the serial number starts 
with the saved current serial number and you can continue to print from where 
you left off with the last print run. If the option is disabled, the serial number is set
to the specified start value.

Label Enter the text that you wish to assign to the serial number as a Prefix or
Suffix. If the text is entered as a prefix, it appears in front of the serial number. If 
the text is entered as a suffix, it appears after the serial number. For example, if 
you enter "Number" under Prefix and select Numeric Serial Numbers as the 
serial number type, the serial number is displayed in the text object as "Number 
1".

Note: This function is not available in all versions of DesignPro.



The Date & Time command (Insert menu)

Use this command or the  icon to insert the date and/or time in a text object. The Date and Time dialog box 
appears.
This command is also available even if no text object is selected. In this case, a text object is inserted automatically 
when the date or time format is selected.
Like all other automatic fields, Date & Time can only be inserted in the master label. They are inactive on all other 
labels and therefore cannot be modified.
You can edit date fields at any time by selecting the Field Parameters command from the Format menu.

To display all the fields in a label, select Print Preview (File menu).

Note: This function is not available in all versions of DesignPro.



Date and Time dialog box
Here you can specify the format in which the date or time is to be inserted.

Format
A list containing different display formats for the date and time is displayed. Select the desired display format and 
click the Insert button. The current date is inserted.

Insert As
Choose between the Field and Text options. If you insert the date and time as a field, the date and time information 
will be updated automatically. Fields are updated automatically when a field is inserted, during printing, when opening
the file and when the Update Fields command is called. If you insert the date and time as text, the current date or 
time is inserted and will not be updated.

Custom
You can define your own formats for the date and/or time using formatting characters. Select Custom and enter the 
format. You can check the result in the preview. The custom format is saved.

Note: This function is not available in all versions of DesignPro.



Custom date and time formats
You can create custom date and time formats using the following symbols.

Symbol Description
d Day with one or two digits (1 to 31)
dd Day with two digits (01 to 31)
ddd The first three letters of the day of the week (Sun to Sat)
dddd Full name of the day of the week (Sunday to Saturday)
M Month with one or two digits (1 to 12)
MM Month with two digits (01 to 12)
MMM The first three letters of the month (Jan to Dec)
MMMM Full name of the month (January to December)
y The last two digits of the year (01 to 99). Identical to "yy".
yy The last two digits of the year (01 to 99).
yyyy Full year (0100 to 9999)
h Hour with one or two digits (0 to 12)
hh Hour with two digits (00 to 12)
H Hour with one or two digits (0 to 24)
HH Hour with two digits (00 to 24)
m Minute with one or two digits (0 to 59)
mm Minute with two digits (00 to 59)
s Second with one or two digits (0 to 59)
ss Second with two digits (00 to 59)
tt Two characters for the twelve-hour clock with the letters AM or PM.
t One character for the twelve-hour clock with the letters A or P.

The custom formats are displayed in the same way here as they are in the Properties dialog box for the Regional 
Settings in the Windows Control Panel. Custom formats that are not compatible with this setting are ignored.
Watch out for uppercase and lowercase when entering a custom format.
You can insert any additional text in the date or time format. The formatting characters listed above must be enclosed 
in single quotes if they are to be used as text and not as format symbols. 

Example:
To obtain a date in the format 
Monday, the 1 February 1999,
enter the following symbols:
dddd, 't''h'e d MMMM yyyy

Note: This function is not available in all versions of DesignPro.



The Euro Conversion command (Insert menu)
Use this command to insert a formatted currency expression including the conversion of the currency from or to Euro 
into a text object. 
The Euro Conversion dialog box appears.
This command is also available even if no text object is selected. In this case, a text object is inserted automatically 
when the Euro Conversion is selected.

Note: This function is not available in all versions of DesignPro.



The Euro Conversion dialog box
In the Euro Conversion dialog box you can define the parameters for the conversion. The following options are 
available:

Currency Choose the currency for the conversion.
Conversion Choose the direction of the conversion. 
Amount Enter the amount to be converted.

The preview shows the result of the conversion.
When choosing the default currency of the operating system, all settings in the regional options in the control panel of
the operating system will be employed in the format of the result. For any non-default currencies the default settings 
of the corresponding country will be used.

Note: This function is not available in all versions of DesignPro.



The Symbol command (Insert menu)
Use this command to insert symbols in a text object. The Symbol dialog box is displayed.



Symbol dialog box
Here you can choose the desired symbol from various character sets and insert it in the selected text object.

1. Select the position where you wish to insert the symbol with the cursor.
2. Under Font, select the font by opening the drop-down list box and choosing the desired font. 
3. The symbols are displayed in the lower section of the dialog box.
4. You can click on the desired symbol with the mouse. The symbol is transferred to the text object when you click 

the Insert button.
5. Click Close to exit the dialog box.



The Picture command (Insert menu)

Use this command or the  icon to insert a graphics file in the current label. The Insert Picture dialog box is 
displayed.
The graphics are only inserted in the label. They cannot be edited. It is possible to change their size, but this may 
affect the quality.

The following graphics formats are supported:
Windows Bitmap Format (BMP)
Windows Metafile Format (WMF)
Tagged Image File Format (TIFF)
JPEG Format (JPG)
PCX Format (PCX)
Encapsulated Postscript Format (EPS)
Kodak Photo CD Format (PCD)
Truevision TARGA File Format (TGA)
WordPerfect Graphic File Format (WPG)
GEM Image File Format (IMG)



Restrictions when printing Windows metafiles (WMF)
Windows metafiles that contain no bitmaps can be mirrored without any restrictions when being printed.
If a metafile does contain a bitmap, this metafile cannot be printed as a mirror image. The object is ignored when the 
mirror image is being printed.
It is recommended that you use a different graphics format in this case.



Restrictions when importing WordPerfect graphics (WPG)
WordPerfect graphics from Versions 5.0 and 5.1 can be imported with DesignPro.
Graphics from Version 6.0 and later cannot be imported. An error message will be displayed in this case.
For WPG files containing vector and/or raster graphics, only the raster graphics are imported.



Restrictions when importing GEM graphics (IMG)
GEM graphics can only be imported as black and white pictures with a colour depth of one bit per pixel (1 bpp). 
Higher colour depths (greyscale or colour images) cannot be imported.
When WinLabel Version 2.02 documents which contain IMG graphics are being converted, IMG images are inverted.



Insert Picture dialog box
In the Insert Picture dialog box you can select the graphics file that you wish to insert.

Look In
Under Look In, specify the directory which is to be searched for graphics files.
The files are displayed in the field and can be selected by clicking on them with the mouse. The graphic is inserted in 
the label by double-clicking on it and can then be placed.

File Name
You can also enter the file name manually in the File Name field. Click Insert to insert the graphic in the label.

Files of Type
Select the file format of the graphic here.

Preview Active
When Preview is enabled you can view the graphic.

You can obtain Help for the individual fields of the dialog box with the What’s This? function by clicking the right 
mouse button.



Supported graphics formats
DesignPro supports the following graphics formats:

Windows Bitmap Format (BMP)
Windows Metafile Format (WMF)
Tagged Image File Format (TIFF)
JPEG Format (JPG)
PCX Format (PCX)
Encapsulated Postscript Format (EPS)
Kodak Photo CD Format (PCD)
Truevision TARGA File Format (TGA)
WordPerfect Graphic File Format (WPG)
GEM Image File Format (IMG)



The Clipart Browser command (Insert menu)
Use this command to insert a clipart into the document. The Clipart Browser dialog box appears.



Clipart Browser dialog box
Use this browser to search for clipart files.
Select the desired drive and directory from the list. All supported graphic files of the selected folder will be displayed 
in the preview as thumbnails.
To insert a clipart in the document either double-click the desired clipart file or select the file and click OK.

Index files are generated automatically when browsing a directory in order to accelerate the display of the thumbnails.
To avoid the generation of index files deactivate the corresponding function on the General Tab of the Options dialog 
box in the Tools menu.



The Design Gallery command (Insert menu)
Use this command to start the Avery Design Gallery application.
This command is only available if Design Gallery is installed.
You can copy clipart from the Design Gallery and insert it in a DesignPro document using the Paste command from 
the Edit menu.



The Directory command (Insert menu)
Use this command to insert a list of files in a text object. 
You can edit and format this list manually in the text object. 
The file list is inserted as text and displays the file information at the time of insertion. The contents of the list are not 
updated after insertion.
This command is also available even if no text object is selected. In this case, a text object is automatically inserted.
The Directory dialog box is displayed.

Note: This function is not available in all versions of DesignPro.



Directory dialog box
In the Directory dialog box you can select the directory and file names for the file list as well as other file information. 
You can select multiple directories or files from different directories.

Look In
Under Look In, specify the directory which is to be searched for files.
The files are displayed in the upper list and can be selected by clicking on them with the mouse. 

File Name
You can also enter the file name manually in the File Name field. 

Files of Type
Here you select the file types which are to be displayed in the upper file list.

Add File
Here you can add the selected file(s) to the directory in the list below.

Add Directory
Here you can add an entire directory with its contents to the list in the lower section of the dialog box.
The Display Subdirectories and Display Hidden Files options allow you to specify whether subdirectories and their
contents and hidden files are to be added to the list. These options must be defined before you add a directory or a 
hidden file, as they cannot be changed afterwards.
You can also enable or disable the Display Full Path option at any time to specify whether or not the complete path 
is to be displayed in the list.

Delete
To delete files from the directory in the lower list, select the relevant files and remove them by clicking this button.

Display Full Path
Select Display Full Path to display the complete path with drive information and directory name in the lower file list. 
This option has no effect on the display of the file list to be inserted in the text object. The setting for selecting 
whether the complete or relative path is displayed in the inserted list is defined in the Preferences dialog box 
(Preferences button).

Display Subdirectories
Select the Display Subdirectories option if you wish to add a directory with its subdirectories and contents to the list.
If this option is disabled, only the contents of the selected directory, without subdirectories, are added to the list.

Display Hidden Files

If the Display Hidden Files option is enabled, you can select files displayed in the upper list and add them to 
the file list (lower field). If this option is disabled, hidden files are only displayed in the upper list; they cannot
be added to the file list.

Preferences
With the Preferences button, you can select the type and scope of file information to be added to the directory in the 
Preferences dialog box.

Note: This function is not available in all versions of DesignPro.



Preferences dialog box
In the Preferences dialog box you can select which of the following file information you wish to add to the directory. 
The display in the Directory dialog box is not affected by these preferences.

Name & Extension
You can separate the file names and extensions into two columns (e.g.: \Business Card      zdp), separate them with a
dot (e.g.: \Business Card.zdp) or display the file names without extensions (e.g.: \Business Card).

Date & Time
In addition to a display without the date and time of the last save, you can also display the date and time in the file list
in two separate columns, combined or just the date alone without the time.

Path
Relative Path: The relative path refers to the parent directory whose contents (subdirectories and/or files) are to be 
added to the file list. It is useful to specify the relative path if files from one folder and its subdirectories or files from 
multiple directories are to be added to the file list.
Full Path: Select the full path to add a complete path for each selected file to the file list together with drive 
information and directory name. Please bear in mind that the full path can be very long.

Size
With the option With File Size you can define whether or not the file size is to be displayed.

Sort List
Select Sort List to insert an alphabetically sorted file list in a text object. 
The individual items of file information are separated by tabs within a line. If the information that you have selected is 
too detailed, it may be split with line breaks within the text object and therefore extend over several lines. 
To display the file information in a single line, you can extend the width of the text object or reduce the font size within
the text object.
You can obtain Help for the individual fields of the dialog box with the What’s This? function by clicking the right 
mouse button.



The Object command (Insert menu)
Use this command to insert a new object in the open document. The Insert Object dialog box is displayed.



Insert Object dialog box
The Insert Object dialog box allows you to select which object type you wish to insert.

1. Select Create New if you wish to create a new OLE object or select Create From File if you wish to create the
OLE object from the file.

2. Select the object type from the list, e.g. "Microsoft PowerPoint 97 Slide" and click OK. The OLE mechanism is 
started.

3. You are still in DesignPro, but now have the features of an OLE-capable application, e.g. Microsoft 
PowerPoint. Create your object.

4. When you have finished editing the OLE object, click on the DesignPro desktop with the left mouse button. 
The link to the OLE application is closed. If you wish to edit the object again, simply double-click on it.

OLE objects cannot be printed as mirror images.



The Grid command (Tools menu)
Use this command to define, enable and disable the grid.
The Grid dialog box is displayed.
Grids allow objects to be snapped. To snap objects, the Snap To Grid function must be enabled in the Grid dialog 
box. 
Select an object and move it with the mouse onto the grid. The object is anchored and placed on a grid line within a 
defined spacing to the grid. 
Irrespective of the zoom factor, the spacing within which objects are anchored remains the same on the screen.
In addition to setting the position of an object, you can also set the size of an object with the grid.



The Grid dialog box
You define the horizontal and vertical grid spacing in the Grid dialog box.
Enable Show Grid to display the grid in the form of dots on the screen. Depending on the defined zoom factor and 
the grid spacing, the grid dots are either completely or only partly drawn. Grid dots not displayed on the screen 
continue to be active however, i.e. the objects are also snapped to these grid lines. 
The simplified display format is used to get a better overview.
Enable Snap To Grid if you want to snap objects to the grid. You can enable or disable the Snap To Grid function 
later with the Snap To Grid command (View menu) or with the  icon.



The Guides command (Tools menu)
Use this command to edit and create guides. The Guides dialog box is displayed.
Guides allow objects to be snapped mutually to a line. 
To snap objects, the Snap To Guides function must be enabled in the Guides dialog box. Select an object and move
it with the mouse onto the guide. The object is anchored within a specific distance to the guide and positioned on the 
guide. 
Irrespective of the zoom factor, the space within which objects are anchored remains the same on the screen.
In addition to setting the position of an object, you can also set the size of an object using guides.



The Guides dialog box
In the Guides dialog box, you define the guides you want to display with the Horizontal Guides and Vertical Guides
tabs.
Enable Show Guides to display all horizontal and vertical guides on the screen.
Enable Snap To Guides if you want to snap objects to guides. You can enable or disable the Snap To Guides 
function later with the Snap To Guides command (View menu) or with the  icon.
You have the option of creating new guides with the New button, or changing the position of a selected guide with the
Edit button. You can also drag guides to the position you want with the mouse.



The Edit Guide dialog box
In the Edit Guide dialog box you can change the position of a selected guide by entering the exact distance to the 
upper label margin.
This procedure offers the advantage of greater precision as opposed to moving objects with the mouse.



The New Guide dialog box
In the New Guide dialog box you create a new guide by manually entering its position.
You can change the position of the guide later, either by entering the new position manually via the Edit button, or by 
using the mouse to move the guide to the position you want.



The Convert LabelPro Database command (Tools menu)
Use this command to convert LabelPro database files with the *.avd extension to the dBase III format (*.dbf) 
supported by DesignPro.
The Convert LabelPro Database dialog box is displayed.

Note: This function is not available in all versions of DesignPro.



The Convert LabelPro Database dialog box
First select the LabelPro database (*.avd) that is to be converted. Use Browse to open the Select LabelPro Database
dialog box.
When converting to a dBase file, some of the existing indices might not be converted. Only data types that are 
supported by DesignPro are converted.
A message is displayed to confirm that the conversion of the LabelPro database file was successful.
If the field names (column title) in the LabelPro database file are too long, the Convert Field Names dialog box 
appears. 
The LabelPro database is converted to the dBase III format. Use Browse to open the Save dBase Database As 
dialog box in which you enter the path and name of the converted file.
The newly created dBase database can be opened with all dbase-compatible programs.
After conversion, you can define whether you want to link the converted database to the current document or not.

Note: This function is not available in all versions of DesignPro.



The Select LabelPro Database dialog box
Select the LabelPro database that you want to convert to the dBase III format supported by DesignPro.

Note: This function is not available in all versions of DesignPro.



The Convert Field Names dialog box
The Convert Field Names dialog box appears if field names (column titles) are used in the LabelPro database that 
exceed the permitted length of 10 characters for dBase files.
DesignPro suggests new field names for the conversion of longer names. You can accept these suggestions or you 
can enter your own field names for the new .dbf file in the Change Field Names dialog box.



The Change Field Names dialog box
Edit the field names here if you want don’t want to use the suggested names.
You have the option of undoing your changes to the field names.



The Update Fields command (Tools menu)
Use this command to manually update fields. All fields, not just those currently selected, are updated within the 
document.
This function can be used to update the date, time or database fields, for example.



The Options command (Tools menu)
Use this command to change or display the default settings for DesignPro.
The Options dialog box is displayed.



The Options dialog box
In the Options dialog box you can edit the default settings for printers, templates, formats, colours, lines and 
directories. Five tabs are available for this:

General
Text Formats
Colours/Lines/Pictures
Print
Directories

Changes to the default settings, with the exception of the printer settings, becomes effective immediately for the 
newly inserted objects. To edit an existing object at a later stage, use the Properties command or the other 
commands in the Format menu.



The General tab

Date and Time Format
The selected default format for date and time information is displayed. Select the Edit button to edit the date format.
Note: This function is not available in all versions of DesignPro.

Bar Code Type
The selected bar code type is displayed. Select the Edit button to edit the bar code.
Note: This function is not available in all versions of DesignPro.

Measurement Unit
You can choose between the following options:

inch
point
centimetre
millimetre
system setting If you selected "metric" in the system settings, DesignPro uses millimetres as the default 

unit.
The settings apply for rulers, dialog boxes and output.
If entries are input in the dialog boxes without having a measurement unit specified, the program settings are applied 
automatically. When making entries, you also have the option of entering the size in other measurement units. Use 
the following abbreviations for this:

inch in
point pt
centimetre cm
millimetre mm

Note: This function is not available in all versions of DesignPro.

User Name
You can enter or change the name of the user here.

By enabling or disabling Display Print Preview with Background, you can determine whether or not predefined, 
pre-printed labels or cards are to be displayed in the print preview with the picture from the template.



The Text Formats tab

Font
The font, point size and font style are displayed here. You can use the Edit button to change the default settings in 
the Font dialog box.
You can make changes to the default settings for the background or fill colour, line colour and line thickness in the 
Colours/Lines/Pictures tab.

Spacing
You can change the line spacing here. To do this select the Edit button.

Text Alignment
The text alignment is defined here. In the Horizontal and Vertical fields you can define the text alignment manually 
or with the scroll bar.

Note: This function is not available in all versions of DesignPro.



The Font dialog box

Font 
You can select the different fonts here. Click the desired font with the mouse. You can select the font style from the

 list in the Text toolbar.

Font Style
You can select here whether the font should appear in italic, bold or bold italic. Select the option you want with the 

scroll bar and select this with a mouse click. You can also use the  icon.

Size
The point size can be selected in the Size field with the scroll bar or you can enter it manually. You can also select the

font size from the  list in the Text toolbar or enter it manually.

Effects
Here you can select whether the text is to be displayed as superscript, subscript or underlined. You can also set 
the colour of the text by opening the field with the mouse and then selecting the colour you want.

Preview
A preview with the entered changes appears in the Preview area. If you want to accept these changes, click OK.

You can obtain Help for the individual fields of the dialog box with the What’s This? function by clicking the right 
mouse button.



The Colours/Lines/Pictures tab

Colours
You can define the default settings for line colour and fill colour here by clicking with the mouse in the corresponding 
field and selecting the colour you want.

Lines
Here you have the option of selecting the default settings for line thickness from a list by clicking the field with the 
mouse and selecting the line thickness you want. You can also define the line thickness in the Custom area by 
entering it manually.

Apply to Text Objects
By activating or deactivating this option, you can define whether the default settings for fill colour, line colour and line 
thickness are also to be applied to text objects and bar codes.
Activate the Apply to Text Objects option if the default settings for background and fill colour, line thickness and line 
colour are also be applied to text objects and bar codes.
If, for example, the default setting for graphics objects is: red fill colour and black borders with 0.1 mm thickness, text 
objects are also assigned a red fill colour and black borders with 0.1 mm thickness, provided this option is enabled. If 
this option is disabled, on the other hand, text objects are shown transparently and without borders.
You can change the default settings for the font colour in the Text Formats tab.

Save Pictures as Reference
By activating the Save Pictures as Reference function, graphics are inserted memory-efficiently in a document. The 
pictures also appear on the screen but are only stored by entering the path and file name.
If the path or file name given as a reference is not found when opening the document, the document is opened 
without the specified picture and an error message appears.

Note: This function is not available in all versions of DesignPro.



The Print tab

Printer
Here you can define the printer with which the labels are to be printed. You have the option of selecting the Windows 
default printer or another printer as the default for DesignPro.
Changing the printer only applies to newly created documents. Existing documents are assigned the settings of the 
previous printer. To activate the changes to the printer settings for existing documents, close and save the document 
and re-open it.

Text Objects
Select Suppress Line Breaks to display the text contents of database fields without line breaks by default. If you want 
to highlight suppressed line breaks in the print preview, enable the Suppressed Line Breaks Highlighted in Print 
Preview function. Under Minimum Point Size you can specify the minimum point size to be applied to the text.

Database
Database fields without content are ignored when printing and in the print preview.

Suppress Spaces Enable this option if the blank that follows an empty database field is to be ignored.

Suppress Blank Lines If there is a blank database field in only one line, you can select this option to ignore 
this line.

Note: These functions are not available in all versions of DesignPro.



The Directories tab
You can define the default directories here.

Documents The documents you created are stored in this directory if you don’t specify a particular 
directory when saving.

Templates The label templates are located in this directory.

Custom Templates Enter the location in which label templates created by you are to be stored here.

Design Gallery The path and file name for the Design Gallery application are located in this directory if the
application is installed. Select Browse to search for the corresponding file in the Find 
Design Gallery dialog box if necessary.

User Manual The path and file name for the User Manual are located in this directory if the User Manual is 
installed. Select Browse to search for the corresponding file in the Find User Manual dialog 
box if necessary.



The Browse for Folder dialog box
The directory structure is displayed in the Browse for Folder dialog box. You can find and select the desired 
directory.

You can obtain Help for the individual fields of the dialog box with the What’s This? function by clicking the right 
mouse button.



The Find Design Gallery dialog box
The directory structure is displayed in the Find Design Gallery dialog box. Select the corresponding application file 
(*.exe).

You can obtain Help for the individual fields of the dialog box with the What’s This? function by clicking the right 
mouse button.



The Find User Manual dialog box
The directory structure is displayed in the Find User Manual dialog box. Select the corresponding Acrobat file (*.pdf).

You can obtain Help for the individual fields of the dialog box with the What’s This? function by clicking the right 
mouse button.



The Master Label command (View menu)
Use this command to toggle to the Master Label. You can also select the master label in the toolbar at the bottom of 
the document.



Master Label
All objects on the master label appear automatically on the remaining labels of the document. These objects can only 
be edited on the master label. The master label objects are covered by the objects on the remaining labels.
Fields (Date & Time and Database fields) can only be inserted in the master label.
If you want to print labels containing an element (e.g. company logo) which is always in the same format, you should 
insert this element in the master label. 



The master label objects appear in all other labels but can only be edited in the master label.
More information on the master label...



The Label Number command (View menu)
Use the following commands to enable and display a specific label.

Go To The Go To dialog box is displayed. Select the desired label by entering the number.
You can also select the label in the tab bar at the bottom border of the document.

First Select this command to go to the first label.

Previous Select this command to go to the previous label.

Next Select this command to go to the next label.

Last Select this command to go to the last label.

You can also toggle between the labels using the buttons on the left next to the bar at the bottom of the document.



Go To dialog box
In the Go To dialog box, enter the number of the label that you wish to view and click OK.
You can also toggle between the labels using the buttons on the left next to the tab bar at the bottom of the 
document.



The Toolbars command (View menu)
Use this command to show/hide toolbars.
The toolbars contain buttons for the most frequently used DesignPro commands, such as Open.

Standard Shows/hides a toolbar containing the most important commands from the File, Edit and Help menus.

Drawing Shows/hides the drawing toolbar.

Formatting Shows/hides the formatting toolbar.

Text Shows/hides the text formatting toolbar.

Database Shows/hides the toolbar for editing databases.

The toolbars can be moved and freely positioned.
You can view ToolTips for the buttons in a toolbar by placing the mouse pointer over the relevant button without 
clicking it. For more detailed Help for a button, use the What’s This? function.



The Ruler command (View menu)
Use this command to show/hide the ruler. The current status is displayed. The ruler is enabled by default.
The measurement unit displayed in the ruler depends on your system settings. You can also change the 
measurement unit under Options in the Tools menu.
The ruler divisions are adjusted automatically according to the zoom factor of the display.
The positions of the mouse, guides and selected objects are displayed in the ruler when they are being edited.



The Status Bar command (View menu)
Use this command to show/hide the status bar.
The status bar describes the action performed by the selected menu item or toolbar button. It also displays the 
selected label template and the size and position of the selected object.
When the status bar is enabled, a check mark appears next to the menu item for this command.

For Help on using the status bar, see Status Bar.



Status Bar
The status bar is displayed at the bottom of the DesignPro window. You can show/hide the status bar in the View 
menu by selecting the Status Bar command.

As you move through the menus using the ARROW KEYS or the mouse pointer, the function of the menu items is 
described on the left of the status bar. Descriptions of the function of the toolbar buttons are also displayed in this 
area when you position the mouse pointer over them.

The centre of the status bar displays the number of the selected label template and the X-Y coordinates of the 
pointer within the active label page in millimetres. When an object is selected, the height and width of the object are 
also shown in the centre of the status bar.

The right of the status bar displays the current line and the column position of the cursor in the case of text fields. 
Each letter counts as a column. At the very right you can see which of the following keys is pressed:
Display Description
CAPS The CAPS LOCK key is pressed.
NUM The NUM LOCK key is pressed.
SCRL The SCROLL LOCK key is pressed.



The Template In Original Colour command (View menu)
With this command you can select whether or not colour templates are to be displayed on the screen in their original 
colour. The current status is displayed in the menu. Templates are displayed in their original colour by default.
If you are using a colour template sheet, it may be better not to display the template in its original colour on the 
screen while you are editing it. The background is displayed in white on the screen in this case.



The Template With Background command (View menu)
With this command you can select whether or not predefined, pre-printed labels or cards are to be displayed on the 
screen with the graphic from the template. 
The current status is displayed. Label templates are displayed with a background graphic by default.
It is a good idea to use this command to disable the background graphic during editing in order to speed up the 
screen refresh rate. The background is displayed in white on the screen in this case.



The Display Text Frames command (View menu)
With this command you can select whether or not to display text with a frame. The text frame is a rectangular border 
around a text object. Round text objects are also displayed with a rectangular frame.
Text frames are not displayed for text objects that are grouped even if the Display Text Frames function is enabled.
The current status is displayed in the menu. This option is enabled by default.



The Field Shading command (View menu)
Use this command or the  icon to highlight fields on the screen. The current status is displayed in the menu. Fields
are displayed with shading by default.



The Display Unprintable Area command (View menu)
Use this command or the  icon to select the area on the screen that cannot be printed on by the printer. 
The size of the unprintable area depends on the selected printer and can vary from printer to printer.
The current status is displayed in the menu. This option is enabled by default.

Unprintable areas occur when the margin of the label sheet is less than the minimum margin area allowed by the 
selected printer. In other words, the area you are trying to print is larger than what can be printed by the printer. 
To prevent labels from being wasted as a result of trying to print in the unprintable area, you can display the 
unprintable areas on the screen. The unprintable areas displayed on the screen do not have to be the same size or 
symmetrical. 
This command is not available when the selected template is a continuous template.



The Snap To Grid command (View menu)
Use this command or the  icon to enable/disable the Snap To Grid function. The current status is 
displayed in the menu.
You can snap objects to a grid, the horizontal and vertical scale of which you can define yourself with the Grid 
command in the Tools menu. 
Click on the objects to align them to the grid. The object is measured and then aligned to the grid at specific 
measurement intervals.
You can also perform this function by selecting the Grid command in the Tools menu.



The Snap To Guides command (View menu)
Use this command or the  icon to enable/disable the Snap To Guides function. The current status is 
displayed.
You can snap objects to horizontal and vertical guides. 
You can define the position of the guides using the Guides command in the Tools menu. You can also click on guides
and move them using the mouse. It is possible to define multiple guides.
Click on the objects to align them to the lines. The object is measured and then aligned to the lines at specific 
measurement intervals.



The Zoom command (View menu)
Use this command or the  icon to zoom into or out of the displayed area. The Zoom dialog box is displayed.

You can also select the zoom factor from the list in the toolbar  or enter it manually.



Zoom dialog box
In the Zoom dialog box you can zoom into or out of the current page using a predefined zoom factor. 
Select Full Page to display all of the current page on the screen. 
You can also enter any value between 20% and 800% in the "Zoom Factor" field. To do this, click the Custom radio 
button.

You can also select the zoom factor from the list in the toolbar .
Not all elements of a document (text, for example) can be reduced or enlarged precisely. The best possible 
approximation is displayed in such cases. When displaying graphics (bitmaps, for example), they may be distorted or 
the quality may be affected.



The New Window command (Window menu)
Use this command to open a window with the same contents as the active window.
You can open several windows so that you can display different sections or views of a document simultaneously. 
When you change the contents in one of the open windows, the changes are applied to all windows containing the 
same document.
When you open a new window, it becomes the active window and is displayed in front of all other windows currently 
open.



The Split command (Window menu)
Use this command to split the active window into panes.
You can also use the mouse or the ARROW KEYS to move the window panes. When you are finished, click the mouse 
button or press ENTER to place the window panes in their new position.



The Cascade command (Window menu)
Use this command to cascade the open windows. The title bars of the window overlap each other in a way that allows
all title bars to be seen.



The Arrange All command (Window menu)
Use this command to arrange all open windows.



The Tile command (Window menu)
Use this command to arrange all open windows.



The Close All command (Window menu)
Use this command to close all open windows.



The Arrange Icons command (Window menu)
Use this command to arrange the icons for the minimised windows in the lower section of the main window. If there is 
already an open window here, some or all of the icons may be hidden because they are underneath the window.



The 1, 2, ... commands (Window menu)
DesignPro displays a list of currently open documents at the bottom of the Window menu. A check mark is displayed 
in front of the name of the active window. Select a document from the list to activate this window.




